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บทคดัย่อ 
 

เขยตายเป็นพืชสมุนไพรในต ารับยาไทยหลายต ารับ มีฤทธิ ์ต ้านการอักเสบ ลดระดับ  
คลอเลสเตอรอลในเลือด ต้านอนุมูลอิสระ นอกจากนี้ยังมีคุณสมบัติยับยั้งโคลีนเอสเตอเรส ซึ่ง
เกี ่ยวข้องกับการเกิดโรคอัลไซเมอร์ ในปัจจุบันยารักษาโรคอัลไซเมอร์มีผลข้างเคียงค่อนข้างมาก 
งานวิจัยนี้มีวัตถุประสงค์เพ่ือศึกษาการเข้าจับระดับโมเลกุลของสารออกฤทธิ์ทางชีวภาพในเขยตายกับ
โปรตีนเป้าหมายที่สัมพันธ์กับการเกิดโรคอัลไซเมอร์ และเพื่อประเมินศักยภาพของสารออกฤทธิ์ทาง
ชีวภาพในเขยตายส าหรับการรักษาโรคอัลไซเมอร์ โดยมีสารออกฤทธิ์ทางชีวภาพในเขยตาย 40 ชนิด
กับโปรตีนเป้าหมายที่สัมพันธ์กับการเกิดโรคอัลไซเมอร์ 46 ชนิด และมียาควบคุมเชิ งบวกที่เกี่ยวข้อง
กับการรักษาโรคอัลไซเมอร์ 23 ชนิด ศึกษารูปแบบการเข้าจับกันระดับโมเลกุล วิเคราะห์อันตรกิริยา 
และท านายคุณสมบัติทางเภสัชวิทยา ผลการวิจัยพบว่า 1-Methoxy-3-methyl-9H-carbazole มีค่า
พลังงานการยึดเกาะต่อโปรตีน Acetylcholinesterase เท่ากับ -8.5 กิโลแคลอรี่ต่อโมล ดีกว่ายา 
Donepezil Galantamine Rivastigmine และ Tacrine ซึ่งมีค่าเท่ากับ -7.8 -7.0 -6.2 และ -7.6 
กิโลแคลอรี่ต่อโมล และ 3-Methoxy-1,2-dimethyl-9H-carbazol-4-one มีค่าพลังงานการยึดเกาะ
ต่อโปรตีน Cholinesterase เท่ากับ -9.2 กิโลแคลอรี่ต่อโมล ดีกว่ายา Galantamine Rivastigmine 
มีค่าเท่ากับ -8.7 และ -7.7 กิโลแคลอรี่ต่อโมล จากการวิเคราะห์อันตรกิริยา พบว่าการยึดเกาะของ
สาร 1-Methoxy-3-methyl-9H-carbazole และยา Donepezil Galantamine Rivastigmine และ 
Tacrine ต่อโปรตีน Acetylcholinesterase มีต าแหน่งแตกต่างกัน สามารถเข้ายับยั้งการท างานของ 
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Acetylcholinesterase แบบไม่แข่งขันกัน อาจพิจารณาใช้เป็นตัวยับยั้งเสริมกันได้ ส่วนการยึดเกาะ
ของ 3-Methoxy-1,2-dimethyl-9H-carbazol-4-one ต่อ Cholinesterase มีการเกิดแรงไฮโดรโฟ
บิกและการเรียงซ้อนพายต าแหน่งเดียวกับ Galantamine 1 ต าแหน่งคือ TRP-82 ซึ่งอาจพิจารณาได้
ว่าสามารถเข้ายับยั้งการท างานของ Cholinesterase เป็นแบบแข่งขันกัน จึงไม่ควรใช้ร่วมกัน แต่มี
ต าแหน่งเข้าจับแตกต่างกันกับ Rivastigmine จึงคาดว่าจะเข้ายับยั้งการท างานของ Cholinesterase 
แบบไม่แข่งขันกัน และสามารถพิจารณาใช้เป็นตัวยับยั้งเสริมกันได้ สุดท้ายการท านายคุณสมบัติทาง
เภสัชวิทยา พบว่า 1-Methoxy-3-methyl-9H-carbazole และ 3-Methoxy-1,2-dimethyl-9H-
carbazol-4-one ผ่านเกณฑ์ตามคุณสมบัติความเป็นยาตามกฎของลิปินสกี้ แสดงถึงความสามารถใน
การดูดซึมและการกระจายตัวที่ดี เมื่อพิจารณาถึงคุณสมบัติเมแทบอลิซึมและความเป็นพิษ สารทั้ง 2 
ชนิดเป็นตัวยับยั ้ง CYP2C19 อาจส่งผลให้สารออกฤทธิ ์ได้นาน และมีความเป็นพิษปานกลาง 
การศึกษานี้สามารถน าไปสู่ทางเลือกกระบวนการรักษาหรือบรรเทาอาการโรคอัลไซเมอร์ในอนาคต 

 
ค าส าคญั: โรคอัลไซเมอร์, เขยตาย, สารออกฤทธิ์ทางชีวภาพ, การจ าลองการเข้าจับกนัของโมเลกุล,  

อันตรกิริยา, การท านายคุณสมบัติทางเภสัชวิทยา 
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ABSTRACT 
Glycosmis pentaphylla (Retz. )  is a traditional Thai herb used in many Thai 

medicine recipes. It was reported to have anti-inflammatory effects, reduce cholesterol 
levels, and possess antioxidant properties.  In addition, it also has cholinesterase 
inhibitory properties which is related to Alzheimer's disease ( AD) .  Since, current 
Alzheimer's medications have many side effects, putative bioactive compounds should 
be assessed as alternatives to treat the disease. This study aimed to investigate binding 
patterns between bioactive compounds from a medicinal plant Glycosmis pentaphylla 
(Retz.) and target proteins associated with AD by using molecular docking techniques, 
molecular interactions and ADMET prediction in order to evaluate their potential for 
treating Alzheimer's disease. The 40 bioactive compounds in Glycosmis pentaphylla 
(Retz. )  and the 23 AD drugs were examined for the best binding energy among 46 
target proteins.  From the analysis of molecular docking, the results showed that the 
binding affinity between 1-Methoxy-3-methyl-9H-carbazole and Acetylcholinesterase 
was -8.5 kcal/mol, better than Donepezil, Galantamine, Rivastigmine and Tacrine which 
were -7. 8, -7. 0, -6. 2 and -7. 6 kcal/mol respectively. The binding affinity between 3-
Methoxy-1,2-dimethyl-9H-carbazol-4-one and Cholinesterase was -9.2 kcal/mol, better 
than Galantamine and Rivastigmine which were -8. 7 and -7. 7 kcal/mol respectively. 
From the analysis of molecular interaction, it was evident that the binding mode of 1-
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Methoxy-3-methyl-9H-carbazole to Acetylcholinesterase differs from that of the drugs 
Donepezil, Galantamine, Rivastigmine, and Tacrine. Therefore, these compounds and 
drugs may inhibit the function of Acetylcholinesterase through noncompetitive 
mechanisms. Hence, they could be considered as complementary inhibitors for 
combined therapeutic approaches while the interaction between 3-Methoxy-1,2-
dimethyl-9H-carbazol-4-one and Cholinesterase resembled that of Galantamine due 
to comparable overlapping binding sites of hydrophobic forces and pi stacking; TRP-
82, implying a potential competitive inhibition mechanism. In contrast, it differed in 
binding position from Rivastigmine hence this indicated their potential as 
complementary inhibitors. In addition, the ADMET predictions indicate that both 1 -
Methoxy-3-methyl-9H-carbazole and 3-Methoxy-1,2-dimethyl-9H-carbazol-4-one met 
the criteria for drug-likeness according to Lipinski's Rule of Five, suggesting good 
absorption and distribution properties. Considering their metabolic and toxicity profiles, 
both compounds inhibited CYP2 C1 9 , potentially prolonging their pharmacological 
effects and exhibiting moderate toxicity. This study could pave the way for future 
therapeutic options or symptom alleviation in Alzheimer's disease. 

 
 
 
 
 

Keywords: Alzheimer’s disease, Glycosmis pentaphylla (Retz.), Bioactive compounds, 
Molecular docking, Molecular interaction, ADMET prediction 
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กติตกิรรมประกาศ 
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ให้ค าปรึกษา ตักเตือน กระตุ้นเสริมสร้างก าลังใจ และช่วยแก้ไขปัญหาในการท าวิทยานิพนธ์นี้อย่างดี
ตลอดมา ด้วยจิตวิญญาณความเป็นครูอย่างเต็มเปี่ยม 
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สาขาเทคโนโลยีชีวภาพ เจ้าหน้าที่คณะวิทยาศาสตร์และเทคโนโลยี มหาวิทยาลัยธรรมศาสตร์ที่คอย
ให้การสนับสนุน และอ านวยความสะดวกในหลาย ๆ ด้าน และขอบคุณ ครอบครัว เพ่ือน พ่ี และน้อง 
ส าหรับก าลังใจในการท าวิทยานิพนธ์นี้ให้ส าเร็จ 
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บทที ่1 
บทน า 

 
1.1 ที่มาและความส าคญั 
 

ความรู้ที่ได้จากการค้นพบและการใช้สืบทอดกันมายาวนานของบรรพบุรุษ ส่งผลให้ปัจจุบัน
สมุนไพรไทยได้รับความสนใจและมีการวิจัยด้านการสกัดและการประเมินประสิทธิภาพของสารออก
ฤทธิ์ทางชีวภาพต่าง ๆ มากขึ้น ทั้งนี้เพื่อเป็นข้อมูลในการน าสมุนไพรมาใช้ประโยชน์อย่างเหมาะสม
และปลอดภัย รวมถึงน าไปสู่การพัฒนาเป็นผลิตภัณฑ์ยา เป็นส่วนผสมในเครื่องส าอาง และในอาหาร
เสริม เป็นต้น เนื่องจากยารักษาโรคในปัจจุบันมีราคาสูง และมีผลข้างเคียงมาก  

เขยตาย (Glycosmis pentaphylla) จัดอยู่ในวงศ์ Rutaceae เป็นพืชสมุนไพรในต ารับยา
ไทยหลายต ารับ (Siriluk et al., 2022) มีลักษณะเป็นไม้พุ่มกึ่งไม้ยืนต้นขนาดเล็ก มีชื่อท้องถิ่น อื่น ๆ 
ว่า ส้มชื่น, ประยงค์ใหญ่, กระรอกน ้า, เขยตายแม่ยายชักปรก, หญ้ายาง และชมชื่น เป็นต้น มีน าสาร
สกัดจากส่วนต่าง ๆ ของเขยตายมาใช้ประโยชน์หลากหลาย ส่วนมากเป็นสารในกลุ่มอัลคาลอยด์และ
เอไมด์ มีฤทธิ์ในการต้านการอักเสบ ลดระดับคลอเลสเตอรอลในเลือด ต้านการอักเสบ (Hongwei 
Chen et al., 2022) ต้านเนื้องอก ต้านอนุมูลอิสระ ต้านไวรัส ต้านเชื้อราและแบคทีเรี ย เป็นต้น 
(Sreejith et al., 2012) นอกจากนี้ยังมีคุณสมบัติยับยั้งโคลีนเอสเตอเรส (Rahman et al., 2017) ซึ่ง
เป็นสาเหตุท าให้เกิดโรคอัลไซเมอร์ อย่างไรก็ตามการศึกษาสมบัติทางเภสัชวิทยาของเขยตายยังมี
จ านวนน้อยมาก 

อัลไซเมอร์ หรือโรคความจ าเสื ่อม เป็นโรคทางสมองเกี่ยวข้องกับความเสื่อมของเซลล์
ประสาทในสมองที่ค่อยๆ ท าลายความจ าและทักษะการคิด สูญเสียการท างานของการรับรู้ การใช้
เหตุผล และความสามารถทางพฤติกรรมจนถึงระดับที่รบกวนชีวิตประจ าวันและกิจกรรมต่าง ๆ 
สาเหตุของโรคอัลไซเมอร์ยังไม่แน่ชัด (Blennow et al., 2016) แต่มีรายงานสมมติฐานหลัก ๆ 
ประการแรกคือ เมื ่อเบตา-อะมีลอยด์สลายจะให้อนุมูลอิสระออกมาท าให้เกิดสภาวะที่เอื ้อต่อ
ความเครียดจากปฏิกิริยาออกซิเดชัน และกระตุ้นให้เซลล์ประสาทเกิดการอักเสบ รวมทั้งภาวะสมดุล
ของแคลเซียม หากขาดภาวะสมดุลแคลเซียมส่งผลเสียต่อระบบประสาทและสมอง ประการที่สองคือ 
อัตราการสังเคราะห์สารสื่อประสาทชนิดอะเซติลโคลีนในสมองลดลงส่งผลต่อการท างานของเซลล์
ประสาท ท าให้การท างานของสมองสูญเสียอย่างต่อเนื่อง (Hardy et al., 2002 และ Agarwal et al., 
2020) ในปัจจุบันมียารักษาโรคอัลไซเมอร์ที่ได้รับการขึ้นทะเบียนจากองค์การอาหารและยาแห่ง
สหรัฐอเมริกาจ านวนน้อย ราคาแพง และมีผลข้างเคียงค่อนข้างมาก อย่างไรก็ตามเคยมีรายงานว่า
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เขยตายมีคุณสมบัติในการยับยั้งอะเซติลโคลีนเอสเทอเรส ซึ่งเป็นเอนไซม์ยับยั้งอะเซติลโคลีนและ มี
ฤทธิ์ต้านการเกิดออกซิเดชัน (Rahman et al., 2017) จึงเป็นที่มาของงานวิจัยนี้ โดยมีวัตถุประสงค์
เพื่อศึกษาการจ าลองการจับของโมเลกุล (molecular- docking) ของสารออกฤทธิ์ทางชีวภาพใน
เขยตายกับโปรตีนเป้าหมายที่สัมพันธ์กับการเกิดโรคอัลไซเมอร์เพ่ือพิจารณาว่าสารสกัดจากเขยตายมี
ประสิทธิภาพในการยับยั้งโปรตีนเป้าหมายที่สัมพันธ์กับการเกิดโรคอัลไซเมอร์ได้หรือไม่ และเพ่ือ
ประเมินศักยภาพของสารออกฤทธิ์ทางชีวภาพในเขยตายต่อโรคอัลไซเมอร์ ซึ่งคาดว่าจะท าให้ได้ข้อมูล
ที่ส าคัญส าหรับทางเลือกในการรักษาหรือป้องกันโรคอัลไซเมอร์ ทั้งยังมีส่วนสนับสนุนข้อมูลของต ารา
ยาไทยให้มีความน่าเชื่อถือมากขึ้น ซึ่งเป็นการส่งเสริมภูมิปัญญาไทยในอีกทางหนึ่งด้วย 
 
1.2 วตัถปุระสงค์งานวจิยั 
 

1.2.1)   เพ่ือศึกษาการเข้าจับระดับโมเลกุลของสารออกฤทธิ์ทางชีวภาพในเขยตายกับ 

โปรตีนเป้าหมายที่สัมพันธ์กับการเกิดโรคอัลไซเมอร์ 

1.2.2) เพ่ือประเมินศักยภาพของสารออกฤทธิ์ทางชีวภาพในเขยตายส าหรับการรักษา 

โรคอัลไซเมอร์ 

 
1.3 ผลที่คาดวา่จะไดร้ับ 

 
      1.3.1) ทราบถึงรูปแบบการเข้าจับโปรตีนของสารออกฤทธิ์ทางชีวภาพในเขยตายกับ

โปรตีนเป้าหมายที่สัมพันธ์กับการเกิดโรคอัลไซเมอร์ 
      1.3.2) ทราบถึงศักยภาพของสารออกฤทธิ์ทางชีวภาพในเขยตายต่อโปรตีนเป้าหมายที่

สัมพันธ์กับการเกิดโรคอัลไซเมอร์ 
 

1.4 สถานที่ท าวจิยั 
 

ห้องปฏิบัติการ B-508 อาคารเรียนบรรยายรวม 5 สาขาเทคโนโลยีชีวภาพ คณะวิทยาศาสตร์ 
และเทคโนโลยี มหาวิทยาลัยธรรมศาสตร์ ศูนย์รังสิต อ าเภอคลองหลวง จังหวัดปทุมธานี 
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บทที ่2 
วรรณกรรมและงานวจิยัทีเ่กีย่วขอ้ง 

 
2.1 เขยตาย 
 

เขยตายหรือ Glycosmis pentaphylla (Retz.) DC. จัดอยู่ในวงศ์ส้ม (Rutaceae) เป็น
พืชเขตร้อนของทวีปเอเชีย และออสเตรเลีย พบได้ในอินเดีย พม่า จีนตอนใต้ ประเทศในแถบ
คาบสมุทรอินโดจีน สุมาตราและชวา ส่วนในประเทศไทยพบขึ้นตามป่าโปร่ง ป่าเบญจพรรณ และตาม
ชายป่า (Labony Khandokar, et al,. 2021, disthai, สืบค้นเมื่อ 2023) มักพบในพื้นที่ความชื้นสูง 
แสงแดดจัด เป็นพันธุ์ไม้หอมที่แข็งแรง เจริญเติบโตเร็ว อดทนต่อสภาพแวดล้อม สามารถขยายพันธุ์
ได้ด้วยวิธีการเพาะเมล็ด การปักช า และการตอนกิ่ง มีชื่อท้องถิ่น อื่น ๆ ว่า กระรอกน ้าข้าว (ชลบุรี) , 
ส้มชื่น (ภาคเหนือ, ภาคตะวันออกเฉียงเหนือ), ตาระแป (มลายู-ยะลา), หญ้ายาง (ภาคใต้), ประยงค์
ใหญ่ (กรุงเทพมหานคร), พุทธรักษา (สุโขทัย), มันหมู (ประจวบคีรีขันธ์) เป็นต้น (Medthai, 2019) 
 

2.1.1 ลกัษณะทางพฤกษศาสตร์ 
              ล าต้น จัดเป็นพรรณไม้พุ่มกึ่งไม้ยืนต้นขนาดเล็ก มีความสูงได้ประมาณ 2-4 เมตร 

แตกกิ่งก้านต ่าตั้งแต่โคนต้นเป็นพุ่มเตี้ย ล าต้นเป็นเหลี่ยม เปลือกล าต้นเรียบเป็นสีน ้าตาลอมเทา ผิวล า
ต้นตกกระเป็นวงสีขาว (Medthai, 2019) 
      ใบ มีลักษณะเป็นใบประกอบแบบขนนก ออกเรียงสลับตรงข้ามหรือกึ่งตรงข้าม 
มีใบย่อยประมาณ 3-5 ใบ ลักษณะของใบย่อยเป็นรูปรีหรือรูปไข่กลับ ปลายใบแหลมถึงกลม โคนใบ
สอบเรียว ส่วนขอบใบเรียบหรือมีรอยจักตื้น ใบมีขนาดกว้างประมาณ 3-5 เซนติเมตร และยาว
ประมาณ 8-14 เซนติเมตร แผ่นใบเรียบ ผิวใบทั้งสองด้านมีจุดต่อม หลังใบเรียบลื่นสีเขียวเข้มเป็นมัน 
ส่วนท้องใบเรียบเป็นสีอ่อนกว่า (Medthai, 2019) 
      ดอก เป็นช่อกระจุกประมาณ 12-15 ดอก ยาวประมาณ 10-30 เซนติเมตร ดอก
มีขนาดเล็กเป็นสีขาว มีกลิ่นหอม โดยจะออกตามซอกใบและที่ปลายกิ่ง กลีบดอกเป็นสีขาว มี 5 กลีบ 
ขนาด 4-5 x 2-2.5 มิลลิเมตร เรียงซ้อนกันเป็นวง ผิวมีต่อมจุด รูปไข่กลับ ส่วนกลีบเลี้ยงที่โคนเชื่อม
ติดกัน ปลายแยกออกเป็น 5 แฉก ยาวประมาณ 1-1.5 มิลลิเมตร รูปแหลมกึ่งรูปไข่ มีขนอ่อนที่ส่วน
ปลาย มีใบประดับหุ้ม โดยชั้นบนจะมี 5 กลีบใหญ่ และมีส่วนย่อยเล็ก ๆ หลายอัน มีต่อมซึ่งเป็นร่อง 
ส่วนก้านชูดอกสั้นมาก เกสรเพศเมียออกเรียงเป็นวง ตรงกลางแกนดอกมีเกสรเพศผู้เป็นแท่ ง ส่วนรัง
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ไข่มีขนาดกว้างประมาณ 2-2.5 มิลลิเมตร เป็นรูปไข่ ดอกมีเกสรเพศผู้ 8-10 อัน ก้านชูอับเรณูยาว
ประมาณ 2-3 มิลลิเมตร (Medthai, 2019) 
      ผล เป็นรูปทรงกลมขนาดเล็ก มีขนาดกว้างประมาณ 1-1.2 เซนติเมตร และยาว
ประมาณ 1.18 เซนติเมตร ปลายผลแหลม ผิวผลเรียบ ผลอ่อนเป็นสีเขียว เมื่อสุกแล้วจะเปลี่ยนเป็นสี
ชมพูใส ฉ ่าน ้า มีรสหวาน ภายในผลมีเมล็ดสีด า 1 เมล็ด เมล็ดมีลักษณะกลม เป็นลาย (Medthai, 
2019)  

2.1.2 ฤทธิท์างเภสชัวทิยา 
     มีฤทธิ์ในรักษาอาการไอ หลอดลมอักเสบ (Babu et al., 2020) ต้านแบคทีเรีย 

(Murugan, et al., 2016) โรคโลหิตจาง โรคดีซ ่าน โรคไขข้อ (Vinitha S Babu et al., 2020)  
เป็นไข้ ความผิดปกติของตับ ติดเชื้อทางเดินปัสสาวะ โรคหนองใน ลดระดับน ้าตาลในเลือด มะเร็ง 
ท้องร่วง โรคบิด การระบาดของพยาธิ ขับน ้านม แก้โรคผิวหนังพุพอง กระทุ้งพิษ แก้พิษฝีทั้งภายใน
และภายนอก ลดระดับคลอเลสเตอรอล ต้านเนื้องอก ต้านอนุมูลอิสระ ต้านไวรัส ต้านเชื้อรา และต้าน
การอักเสบ นอกจากนี้รายงานวิจัยยังพบว่ามีคุณสมบัติในการยับยั ้ง Cholinesterase ให้มีการ
สังเคราะห์ acetylcholine มากขึ้น ส่งผลดีต่อระบบประสาทและสมอง (Rahman et al,. 2017, 
Labony Khandokar et al,. 2021) สารพฤกษเคมีหลักเช่น ฟลาโวนอยด์ (Yi Wu et al., 2012)  
เอไมด์ คูมาริน อาร์โบรีน (Sreejith PS et al., 2012) อัลคาลอยด์ และเทอร์พีนอยด์ (Ahmed et 
al., 2012) เป็นต้น 
 
2.2 โรคอลัไซเมอร ์
 

      โรคอัลไซเมอร์เป็นโรคที่เกี่ยวข้องกับสมองส่วนที่ควบคุมความคิด ความจ า และภาษา 
เกิดจากความเสื ่อมของระบบประสาทซึ ่งมักจะเริ ่มอย่างช้า ๆ และแย่ลงเรื ่อย ๆ เกิดจากการ
เปลี่ยนแปลงในสมอง น าไปสู่การสะสมของโปรตีนบางชนิด ซึ่งท าให้สมองหดตัวและเซลล์สมองตาย
ในที่สุด โดยอาการเริ่มแรกอาจมีความจ าถดถอยจนตัวเองรู้สึกได้ พูดซ ้า ๆ เรื่องเดิม สับสนทิศทาง 
เริ่มเครียด อารมณ์เสียง่ายและซึมเศร้า จากนั้นจะเริ่มมีการสูญเสียความทรงจ าเล็กน้อย สุดท้ายอาจ
สูญเสียความจ าทั้งหมดและน าไปสู่การสูญเสียความสามารถในการสนทนาและการตอบสนองต่อ
สิ่งแวดล้อม อาจส่งผลกระทบร้ายแรงต่อความสามารถของบุคคลในการด าเนินกิจกรรมประจ าวัน 
และเป็นสาเหตุของภาวะสมองเสื่อม 60–70% พบมากในผู้สูงอายุที่มีอายุมากกว่า 60 ปี (Dinda B, 
et al., 2019, mayoclinic, 2015, Boris Decourt, et al., 2022) 
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2.2.1 สมมตฐิานการเกดิโรคอลัไซเมอร ์

ปัจจุบันสาเหตุของการเกิดโรคอัลไซเมอร์ยังไม่เป็นที่ทราบแน่ชัด อย่างไรก็ตามมี
การตั้งสมมติฐานของการเกิดโรค ดังนี้ 

2.2.1.1 Cholinergic hypothesis 
เป็นสมมติฐานที่เก่าแก่ที่สุดเป็นพื้นฐานของยาที่มีอยู่ในปัจจุบัน ซึ่งเสนอว่า 

โรคอัลไซเมอร์จากกิจกรรมการท างานของเอนไซม์ choline acetyltransferase ลดลง ในสมองส่วน 
amygdala, hippocampus และ cortex โดยที่อัตราการสังเคราะห์และการขนส่งสารสื่อประสาท
ชนิด acetylcholine ในสมองลดลงที่บริเวณ synapses (Robert Briggs, et al., 2016, Liu PP, et 
al., 2019,  Agarwal M, et al., 2020, Boris Decourt, et al., 2022) 

 
ภาพที ่2.1 วิถ ีacetylcholine ที่มา: (CNSforum.com) 

2.2.1.2 Amyloid-Beta hypothesis 
   สมมติฐานนี้ได้รับการยอมรับมากที่สุดในหมู่นักวิจัย เนื่องจากค าอธิบาย

เกี่ยวกับการก่อตัวของ amyloid plaque และการสะสมของ Amyloid-beta (Aβ) ซึ่งเป็นจุดเด่นที่
ส าคัญของโรคอัลไซเมอร์ เกิดจากการกลายพันธุ์ในต าแหน่งของยีน amyloid-beta precursor 
protein (APP) บนโครโมโซมคู่ที่ 21 โดยปกติ APP จะถูกไฮโดรไลซ์โดยเอนไซม์ alpha-secretase 
จะได้ sAPP-alpha ละลายน ้าได้ และ C83 fraction มีหน้าที่ส่งเสริมเกี่ยวกับความจ า การเรียนรู้ของ
สมอง และรักษาสภาวะความเครียดของเส้นประสาท แต่ในคนที่เป็นโรคอัลไซเมอร์ APP จะถูกไฮโดร
ไลซ์โดยเอนไซม์ beta-secretase จะได้ sAPP-beta ไม่สามารถละลายน ้าได้ และ C99 fraction 
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จากนั้น เอนไซม์ gamma-secretase ท าการไฮโดรไลซ์ C99 fraction ได้ Aβ 2 หน่วยย่อย (Aβ 40 

ไม่สามารถละลายน ้าได้ หรือ Aβ 42 ละลายน ้าได้) ซึ่งท าให้เกิด amyloid plaque ท าให้เกิดการ
ขัดขวางการท างานของ sAPP ซึ่งน าไปสู่การเปลี่ยนแปลงทางเมแทบอลิซึม ส่งผลให้เกิดสภาวะที่เอ้ือ
ต่อความเครียดจากปฏิกิริยาออกซิเดชัน และภาวะสมดุลของแคลเซียม ส่งผลให้เกิดโรคอัลไซเมอร์ได้ 
(Robert Briggs, et al., 2016, Liu PP, et al., 2019,  Agarwal M, et al., 2020, Boris Decourt, 
et al., 2022) 

 
ภาพที ่2.2 วิถ ีamyloid-beta precursor protein ที่มา: (acrobiosystems.com) 

2.2.1.3 Inflammatory hypothesis 
   การอักเสบของระบบประสาทถือว่าเป็นผลต่อเนื่องในสมมติฐานของอะไม
ลอยด์ โดยที่การตอบสนองการอักเสบของ microglia และ astrocytes ในระบบประสาทส่วนกลางมี

บทบาทส าคัญท าให้เกิดโรคอัลไซเมอร์ การศึกษาในหลอดทดลองได้เชื่อมโยงพยาธิวิทยาของ Aβ ใน

โรคอัลไซเมอร์ กับการอักเสบของระบบประสาท แสดงให้เห็นว่า Aβ มีผลในการกระตุ้นการท างาน

ของ microglia ที่เกิดจากไซโตไคน์ ในผู้ป่วยอัลไซเมอร์ Aβ สามารถจับกับเซลล์ microglia ผ่านทาง 
D36-TLR4-TLR6 receptor complex และ the NLRP3 inflammatory complex จะปล่อยปัจจัย

ที่กระตุ ้นการอักเสบ เช่น TNF-α และท าให้เกิดการตอบสนองของระบบภูมิคุ ้มกัน ท าให้เซลล์

ประสาทเสียหาย นอกเหนือจากระดับที่เพ่ิมข้ึนของ TNF- α แล้ว ระดับท่ีเพ่ิมข้ึนของไซโตไคน์ที่มีการ

อักเสบ IL-1β, TGF-β, IL-12 และ IL-18 ในระบบประสาทส่วนกลางยังเพิ่มความเสียหายในสมอง 
และมีความสัมพันธ์กับการลุกลามของโรคอัลไซเมอร์ (Pei-Pei Liu et al., 2019) 

2.2.1.4 Calcium homeostasis and NMDA hypotheses 
   แคลเซียมในเซลล์มีบทบาทส าคัญในการควบคุมการท างานของเซลล์
ประสาท เช่น neural growth and differentiation, action potential, and synaptic plasticity. 
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สภาวะสมดุลแคลเซียมมีความสัมพันธ์กับความจ าและการเรียนรู้ เป็นผลต่อเนื่องในสมมติฐานของอะ

ไมลอยด์ ในปี 1992 Mattson และคณะ ได้เสนอสมมติฐานว่า Aβ ส่งผลต่อสภาวะสมดุลแคลเซียม 
ท าให้แคลเซียมไหลเข้าสู่เซลล์ประสาทอย่างต่อเนื่อง เมื่อระดับแคลเซียมภายในเซลล์เพิ่มขึ้น อาจท า
ให้เซลล์ประสาทเสี่ยงต่อสิ่งเร้าจากสิ่งแวดล้อมมากข้ึน (Michael, 2010, Cascella, et al., 2021) 

 

ภาพที ่2.3 Calcium homeostasis and NMDA hypotheses ที่มา: (Michael, 2010) 

2.2.1.5 Tau propagation hypothesis 
ลักษณะการก่อโรคที่โดดเด่นอีกประการหนึ่งของผู้ป่วยอัลไซเมอร์คือ 

neurofibrillary tangles (NFTs) เก ิ ดจากโปรต ีน เทาม ี ก าร เต ิ มหม ู ่ ฟอส เฟตมาก เก ิ น ไป 
(hyperphosphorylated tau) ซึ่งโปรตีนเทาเกาะอยู่กับไมโครทูบูล ท าหน้าที่ท าให้ไมโครทูบูลมี
ความเสถียรภาพ ส่งผลให้เกิดการแยกโพลีเมอร์ของไมโครทูบูลและความผิดปกติของแอกซอน ซึ่ง
น าไปสู่การเสื่อมของเซลล์ประสาทและการตายของเซลล์ประสาท ส่งผลให้เกิดโรคอัลไซเมอร์ การเติม
หมู่ฟอสเฟตที่ผิดปกติของโปรตีนเทาเกิดจากการแสดงออกในระดับสูงของไคเนสฟอสโฟรีเลชั่นต่าง ๆ 

เช ่น glycogen synthase kinase 3β (GSK- 3β), cyclin-dependent kinase 5 (CDK5) , และ 
tyrosine kinase ซึ่งถือเป็นเป้าหมายยาที่เป็นไปได้ส าหรับการรักษาโรคอัลไซเมอร์  (Robert Briggs, 
et al., 2016, Kametani F, et al.,2018, Liu PP, et al., 2019,  Agarwal M, et al., 2020) 
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ภาพที ่2.4 การเติมหมู่ฟอสเฟตของโปรตีนเทา ที่มา: (NIA/NIH.) 

2.2.1.6 Mitochondrial cascade hypothesis and related hypotheses 
ในปี 2004 Swerdlow และ Khan ได้เสนอสมมติฐานนี้ว่า ไมโทคอนเดรีย 

อาจส่งผลต่อการแสดงออกและการประมวลผลของยีน APP และการสะสมของ Aβ ในสมมติฐานนี้
จะประกอบด้วย 3 ประการ ประการแรก การท างานของไมโทคอนเดรียจะถูกก าหนดโดยการ
ถ่ายทอดทางพันธุกรรม ประการที่สอง อัตราการ เปลี่ยนแปลงที่เกี่ยวข้องกับอายุ ซึ่งพิจารณาจาก
ปัจจัยทางพันธุกรรมและสิ่งแวดล้อม และหากประสิทธิภาพของไมโทคอนเดรียลดลงจะส่งผลให้เกิด
การเปลี่ยนแปลงฟีโนไทป์ของผู้สูงอายุ ประการที่สาม อัตราการเปลี่ยนแปลงการท างานของไมโทคอน
เดรียในแต่ละคนจะส่งผลต่อการเกิดโรคอัลไซเมอร์ (Pei-Pei Liu et al., 2019) 

 
ภาพที ่2.5 Mitochondrial cascade hypothesis and related hypotheses  

ที่มา: (Pei-Pei Liu et al., 2019) 
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2.2.1.7 Neurovascular hypothesis 
การศึึกษาผู้ป่วยโรคอัลไซเมอร์พบว่ามีความผิดปกติของระบบประสาทและ 

หลอดเลือดก่อนที่จะเริ่มมีอาการของสมองเสื่อม สภาวะสมดุลของสิ่งแวดล้อมภายในเซลล์ขนาดเล็ก
และเมแทบอลิซึมในสมองขึ้นอยู่กับการส่งสารตั้งต้นและการระบายของเสียผ่านทางเลือด , เซลล์
ประสาท, astrocytes เพื่อสร้างการท างานที่สนับสนุนความสมบูรณ์ของโครงสร้างและหน้าที่ของ
สมอง ซึ่งความผิดปกติของหลอดเลือดจะน าไปสู่ความผิดปกติของสมองและโรคทางระบบประสาท 
รวมถึงโรคอัลไซเมอร์ (Pei-Pei Liu et al., 2019) 
   จากรายงานงานวิจัยแสดงให้เห็นว่าระดับคอเลสเตอรอลสูง ภาวะไขมันใน
เลือดสูง เป็นปัจจัยที่ส่่งผลต่อระบบประสาทมีความเสี่ยงในการเป็นโรคอัลไซเมอร์ และผู้ป่วยที่มีภาวะ
น ้าตาลในเลือดสูง หรือผู ้ป่วยเบาหวานชนิดที ่ 2 มีความเสี ่ยงในการเป็นโรคสมองเสื ่อมเพิ่มขึ้น 
(Hassing et al., 2009) 

2.2.2 การรกัษาโรคอลัไซเมอร ์
      ปัจจุบันยังไม่มีวิธีการรักษาที่ท าให้โรคอัลไซเมอร์หายขาด แต่สามารถดูแลรักษา
แบบประคับประคองตามอาการและปัญหาที่เกิดขึ้น ชะลอภาวะสมองให้เสื่อมช้าที่สุดเพื่อเพ่ิมคุณภาพ
ชีวิตของทั้งผู้ป่วยและผู้ดูแล และป้องกันอันตรายที่อาจเกิดขึ้นจากภาวะแทรกซ้อนต่าง ๆ ได้ ด้วย
วิธีการรักษาที่หลากหลาย เนื่องจากการศึกษาสาเหตุการเกิดโรคอัลไซเมอร์ยังไม่แน่ชัด ส าหรับ
แนวทางการรักษาโรคอัลไซเมอร์แบ่งออกเป็น 3 รูปแบบ คือ การรักษาโดยไม่ใช้ยา การรักษาโดยใช้
ยา และการรักษาโดยใช้สารผลิตภัณฑ์ธรรมชาติ เป็นทางเลือกในการรักษา 

2.2.3 การรกัษาโดยไม่ใชย้า 
      ท าความเข้าใจการวินิจฉัย ธรรมชาติของโรค และอาการที่อาจเกิดขึ้นในอนาคต 
เพื่อวางแผนการดูแลระยะยาว แก้ไขข้อจ ากัดและปัจจัยเสี่ยงที่ท าได้ เช่น ปัญหาการได้ยิน สายตา 
โรคประจ าตัว ให้ผู้ป่วยอยู่ในสิ่งแวดล้อมที่คุ้นเคย ปลอดภัย จัดตารางกิจกรรมแต่ละวันให้เหมือนเดิม
ทุกวัน จัดกิจกรรมกระตุ้นสมองที่ผู้ป่วยคุ้นเคย ชื่นชอบ และไม่ก่อให้เกิดความเครียด ปรับพฤติกรรม
โดยเน้นวิธีที่ถูกใจผู้ป่วย ไม่จ าเป็นต้องถูกต้องหากไม่เป็นอันตราย ฝึกหรือให้ความช่วยเหลือผู้ป่วยให้
ท ากิจวัตรประจ าวันที่ผู้ป่วยยังพอท าเองได้  ดูแลสุขภาพกาย สมดุลชีวิตของผู้ดูแลให้สามารถดูแล
ผู้ป่วยอย่างมีคุณภาพ ดูแลให้ผู้ป่วยได้นอนหลับอย่างมีคุณภาพตามสุขลักษณะการนอน เช่น ไม่ดื่ม
สารคาเฟอีนในช่วงเย็นหรือก่อนนอน ไม่ออกก าลังกายใกล้กับเวลานอน เข้านอนและตื่นนอนตรงเวลา 
ปรับความสว่างในห้องนอนให้มืดพอดี เพราะหากวงจรการนอนไม่ดีจะส่งผลต่อภูมิคุ้มกันของร่างกาย 
ความดันโลหิต น ้าหนัก และรวมถึงความจ าด้วย ดื่มน ้าให้พอเพียง เพื่อป้องกันภาวะเลือดหนืดหรือ
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เลือดข้นซึ่งท าให้เลือดไหลเวียนไม่สะดวก สมองไม่สดชื่น หากไม่มีข้อห้าม เช่น มีโรคหัวใจหรือโรคไต 
ควรดื่มน ้าวันละ 2 ลิตรเป็นอย่างน้อย (สุขเจริญ, 2023) 

2.2.4 การรกัษาโดยใชย้า 
 ปัจจุบันยาหลักที่ใช้ในการรักษาโรคอัลไซเมอร์ ได้แก่ ยายับยั้งการท างานของ

เอนไซม์โคลีนเอสเทอเรส (Cholinesterse inhibitors: ChEIs) และยายับยั้งการท างานของสารสื่อ
ประสาทชนิดกลูตาเมท (NMDA Receptor Antagonist) ส าหรับผู้ป่วยในระดับอาการรุนแรงปาน
กลางถึงมาก (moderate to severe ) และยาอื่นๆ มีรายละเอียด ดังต่อไปนี้ (อ าไพ พิมพ์ไกร และ
คณะ, 2021, alzheimersresearchuk, 2024) 

2.2.4.1 ยาในกลุ่ม Cholinesterase inhibitors: ChEIs : 
 (1) Donepezil ได้รับการขึ้นทะเบียนจาก FDA ส าหรับรักษาโรคอัลไซ- 

เมอร ์ ในท ุกระยะ โดยออกฤทธ ิ ์ย ับย ั ้ ง  acetylcholinesterase (AChE) ซ ึ ่ งม ีหน ้าท ี ่ท  าลาย 
acetylcholine ด้วยปฏิกิริยา hydrolysis จึงท าให้ปริมาณ acetylcholine ในเซลล์ประสาทสมอง
เพ่ิมข้ึน ส่งผลต่อความจ า รวมทั้งความผิดปกติทางด้านอารมณ์และความนึกคิด แต่ด้วยฤทธิ์ของยาท า
ให้ไปเพิ่ม Cholinergic Activity ที่ทางเดินอาหาร ท าให้เกิดผลข้างเคียง เช่น คลื่นไส้ อาเจียน นอน
ไม่หลับ หัวใจเต้นช้า และเหนื่อยล้า เป็นต้น 

 
ภาพที่ 2.6 ภาพแสดงโครงสร้างของมิติของ Donepezil ที่มา: wikipedia 

   (2) Rivastigmine ได้รับการขึ้นทะเบียนจาก FDA ส าหรับรักษาโรคอัลไซ
เมอร ์ในระยะต ้นถ ึงระยะกลาง ออกฤทธ ิ ์ย ับย ั ้ งได ้ท ั ้ ง acetylcholinesterase (AChE) และ 
Butyrylcholinesterase (BuChE) ส่งผลท าให้การเรียนรู้ ความจ า อาการทางจิตของผู้ป่วยและการ
แสดงออกทางด้านพฤติกรรมดีขึ ้น อาการข้างเคียงมักเกิดขึ้นเมื่อใช้ในขนาดมากกว่า 6 mg เช่น 
คลื่นไส้ อาเจียน ปวดท้อง และไม่อยากอาหาร 

 
ภาพที ่2.7 ภาพแสดงโครงสร้างของมิติของ Rivastigmine ที่มา: Wikipedia 
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(3) Galantamine ได้รับการขึ้นทะเบียนจาก FDA ส าหรับรักษาโรคอัลไซ 
เมอร์ในระยะต้นถึงระยะกลาง เป็น tertiary alkaloid ออกฤทธิ ์ย ับยั ้งอย่างจ าเพาะต่อ AChE 
นอกจากนี้ยังยับยั้ง presynaptic nicotinic modulator ด้วย ซึ่งยังไม่มีข้อมูลเกี่ยวกับกลไกนี้ว่ามี
ความส าคัญทางคลินิกอย่างไร อาการข้างเคียงท่ีเกิดข้ึนเป็นอาการเกี่ยวกับระบบทางเดินอาหาร 

 
ภาพที ่2.8 ภาพแสดงโครงสร้างของมิติของ Galantamine ที่มา: Wikipedia 

(4) Tacrine เป็นตัวยับยั้ง cholinesterase ตัวแรกท่ีได้รับการอนุมัติจาก  
FDA ส าหรับการรักษาโรคอัลไซเมอร์เมอร์ในระยะต้นถึงระยะกลาง เป็นสารยับยั้งโคลีนเอสเตอเรส
แบบพลิกกลับได้ซึ่งจับกับซีรีนที่เร่งปฏิกิริยาในบริเวณที่ท างานของโปรตีน ผลข้างเคียงที่พบบ่อย 
ได้แก่ อาการทางเดินอาหาร (คลื่นไส้ อาเจียน ท้องร่วง ปวดท้อง) และไม่ค่อยมีอาการปวดกล้ามเนื้อ
และเวียนศีรษะ (Nicholas et al., 2001) 

 
ภาพที่ 2.9 ภาพแสดงโครงสร้างของมิติของ Tacrine ที่มา: Wikipedia 

2.2.4.2 ยาในกลุ่ม N-methyl-D-aspartate(NMDA)Receptor Antagonist : 
(1) Memantine ได้รับการขึ้นทะเบียนจาก FDA ส าหรับรักษาโรคอัลไซ- 

เมอร์ระยะกลางถึงหนัก ช่วยปกป้องเซลล์ประสาทในสมองจาก glutamate ที่มีมากเกินไป โดยการ
ช่วยการท างานของ signal-to-noise ratio ของ glutamatergic transmission ที่ NMDA receptor 
ซึ่งสารสื่อประสาทนี้เกี่ยวข้องกับโรคอัลไซเมอร์ ส่งผลให้การเรียนรู้ และความจ าของผู้ป่วยอัลไซเมอร์
ดีขึ้น อีกทั้งการใช้ Memantine ร่วมกับยาในกลุ่ม Cholinesterase Inhibitors ท าให้ประสิทธิภาพ
ในการรักษาดีกว่าการใช้ยาตัวใดตัวหนึ ่ง อาการข้างเคียงที ่เกิดขึ ้น ได้แก่ คลื ่นไส้ เวียนศีรษะ 
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(Dizziness) กระสับกระส่าย (Restlessness) ความคิดสับสน (Confusion) และประสาทหลอน 
(Hallucination) 

 
ภาพ 2.10 ภาพแสดงโครงสร้างของมิติของ Memantine ที่มา: Wikipedia 

2.2.4.3 ยาในกลุ่ม Anti-amyloid therapy : 
(1) Aducanumab ได้รับการขึ้นทะเบียนแบบเร่งด่วนจาก FDA ในปี  

2021 ซึ่งเป็น human monoclonal antibody ใช้ในการรักษาโรคอัลไซเมอร์ระยะ mild cognitive 
impairment (MCI) หรือ mild AD ผลการศึกษาทางคลิน ิกพบว ่า aducanumab สามารถลด 
amyloid plaques ในสมองของผู้ป่วยโรคอัลไซเมอร์ได้ (Dhillon, 2021) 
   (2) Lecanemab ยาล่าสุดที่ได้รับการขึ้นทะเบียนแบบเร่งด่วนจาก FDA 

ในปี 2023ส าหร ับร ักษาโรคอัลไซเมอร ์ระยะต้น เป ็น anti-amyloid beta (Aβ) protofibril 
antibody ช่วยลดการสะสมของโปรตีน Amyloid Beta ที่จับตัวกันเป็น Amyloid Plaques ซึ่งเมื่อ
ไปจับกับเซลล์สมองจะส่งผลให้เซลล์สมองเสื่อมและฝ่อลง โดยจะเข้าจับกับโปรตีน beta amyloid ที่
ก่อตัวขึ้นในสมองของผู้ป่วยโรคอัลไซเมอร์ (BBC 2022, The Coverage 2023) 

2.2.5 การรกัษาโดยใชส้ารผลติภัณฑธ์รรมชาติ 
      เนื่องจากการรักษาโรคอัลไซเมอร์โดยใช้ยาในปัจจุบันมีค่าใช้จ่ายสูง ดังนั้นการ
รักษาโดยใช้สารผลิตภัณฑ์ธรรมชาติที่มีสรรพคุณช่วยบ ารุงสมอง ช่วยเพิ่มจ านวนเซลล์ประสาท สร้าง
สารสื่อประสาทในสมอง เพิ่มความจ า ลดการท าลายเซลล์ประสาท เพิ่มการไหลเวียนของเลือดที่ไป
เลี้ยงสมอง ลดการอักเสบของสมอง จึงเป็นทางเลือกหนึ่งในการรักษาที่น่าสนใจ พืชสมุนไพรที่มีฤทธิ์
ป้องกันและรักษาโรคอัลไซเมอร์ ได้แก่  
       บัวบก มีสรรพคุณที่ออกฤทธิ์ต่อระบบต่าง ๆ ในร่างกาย ที่โดดเด่นต่อการบ ารุง
สมองของใบบัวบกได้แก่ มีฤทธิ์เพิ่มระดับสารสื่อประสาทในสมอง มีสารต้านอนุมูลอิสระสูง และช่วย
เพิ่มการไหลเวียนของเลือดที่ไปเลี้ยงสมอง ไม่ให้สมองอยู่ในภาวะของการขาดเลือด  (HDmall สืบค้น
เมื่อ 2024) 
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       พรมมิ หรือ ผักมิ มีความนิยมในต ารับยาอายุรเวทของอินเดีย ซึ่งจากงานวิจัย
พบว่า พรมมิมีสรรพคุณที่ช่วยเพิ่มประสิทธิภาพของความจ า การตัดสินใจ ช่วยปกป้องเซลล์สมอง มี
ฤทธิ์ต้านความจ าเสื่อม และช่วยในเรื่องการนอนหลับ โดยการกระตุ้นสารสื่อประสาทและเพิ่มการ
ไหลเวียนของเลือดที่ไปเลี้ยงสมอง นอกจากนี้พรมมิเองยังช่วยลดความตื่นเต้นและคลายความเครียด
ได้ดีรวมไปถึงช่วยลดการอักเสบของสมองและช่วยปกป้องเซลล์สมอง  (กรมการแพทย์แผนไทยและ
การแพทย์ทางเลือก, 2023) 
       กลีบบัวแดง จัดเป็นสมุนไพรที่มีรสหอมเย็น ที่มีสรรพคุณบ ารุงหัวใจ แก้ไข้ แก้
ร้อนใน กระหายน ้า จากการศึกษาวิจัย พบว่ากลีบบัวแดงมีฤทธิ์ยับยั้งการท างานของเอนไซม์ชนิดหนึ่ง
ที่มีผลต่อสารสื ่อประสาท มีฤทธิ์ต้านอนุมูลอิสระ และมีฤทธิ ์ยับยั้งการเกาะกลุ่มกันของโปรตีน 

Amyloid-beta (Aβ)  ซึ่ รวมทั้งพบว่ามีฤทธิ์ป้องกันการท าลายเซลล์ประสาทได้ ซึ่งมีผลช่วยป้องกัน
ภาวะสมองเสื่อมท้ังชนิดความจ าระยะสั้นและความจ าระยะยาวได้ (Maneenet J, et al., 2019)  
       ขมิ้นชัน มีสรรพคุณที่หลากหลาย ช่วยรักษาหรือบรรเทาอาการต่าง ๆ ของ
ร่างกายได้หลายระบบ ส าหรับในสมองนั้นขมิ้นชันจะช่วยป้องกันการเกาะกลุ่มของโปรตีน Amyloid-

beta (Aβ) เมื่อสารตัวนี้ไม่เกาะกลุ่มกันไปขัดขวางการท างานของเซลล์สมองก็จะท าให้เซลล์สมอง
สามารถท างานได้อย่างเป็นปกติ และมีฤทธิ์ยับยั้งเอนไซม์โคลีนเอสเตอเรสไม่ให้ถูกท าลายลงได้ง่ายอีก
ด้วย อีกทั้งยังช่วยลดความเครียดที่เป็นสาเหตุหนึ่งโรคอัลไซเมอร์ (Healthykare, 2021) 
       ดอกอัญชัน มีสรรพคุณที่โดดเด่น คือ การเพิ่มการไหลเวียนของเลือดและช่วย
ขยายหลอดเลือดขนาดเล็กให้ท างานได้อย่างเต็มที่จึงช่วยเพิ่มปริมาณของเลือดที ่ไปเลี ้ยงสมอง  
(Healthy Kare สืบค้นเมื่อ 2024) 
       แปะก๊วย มีสาร EGb 761 มีฤทธิ ์ยับยั ้งการท าลายเซลล์ประสาทที่เกิดจาก 

hydroxyl radical, staurosporine และ Amyloid-beta (Aβ) และจากหลายงานวิจัยที ่บ ่งช ี ้ว่า
แปะก๊วยสามารถเพิ่มการไหลเวียนของเลือดในสมอง ท าให้เซลล์สมองได้รับเลือดมาเลี้ยงมากขึ้น 
(Healthykare, 2021) 
       ผักโขม  มีปริมาณของกรดโฟลิกสูง และมีเอนไซม์ที่มีประโยชน์ต่อระบบประสาท 
นอกจากนี้ยังมีสรรพคุณในการช่วยลดอาการของความจ าเสื่อม (Healthykare, 2021) 
       ผลไม้ตระกูลเบอร์รี ่ เป็นแหล่งรวมสารต้านอนุมูลอิสระที ่ได้รับการยอมรับ 
นอกจากนี้ในเบอร์รี่แต่ละชนิดก็ยังอุดมไปด้วยสารอาหารที่เป็นประโยชน์ต่อร่างกายหลายชนิด แต่
สรรพคุณท่ีมีต่อสมองคือช่วยเพิ่มการไหลเวียนเลือดและช่วยเพิ่มจ านวนเซลล์ประสาท(Healthy Kare 
สืบค้นเมื่อ 2024) 
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2.3 การจ าลองการเข้าจับกันของโมเลกุล (Molecular docking) 
 
      เป็นเทคนิคทางคอมพิวเตอร์ส าหรับจ าลองการเข้าจับระหว่างลิแกนด์  (ligand)กับ
โมเลกุลเป้าหมาย (Receptor) ที่สนใจ แล้วรายงานผลออกมาเป็นค่าพลังงานการเข้าจับ (Binding 
affinity) การจ าลองการเข้าจับกันของโมเลกุลเป็นเครื่องมือส าคัญท่ีช่วยในการเข้าใจสารประกอบทาง
เคมีที่มีปฏิสัมพันธ์กับโมเลกุลเป้าหมาย ใช้ท านายผลทางเภสัชวิทยาอย่างมีประสิทธิภาพ ในการ
ทดลองทางคอมพิวเตอร์ (In Silico) โดย Fisher ได้เสนอทฤษฎี Lock-and-Key ครั้งแรกในปี ค.ศ. 
1894 อธิบายปฏิสัมพันธ์ระหว่างโมเลกุลเป้าหมาย (receptor) กับลิแกนด์ (ligand) ซึ่งสามารถจดจ า
ซึ่งกันและกันผ่าน geometric matching และ energy matching โดยลิแกนด์เชื่อมต่อกับโมเลกุล
เป้าหมายมีลักษณะคล้ายลูกกุญแจกับแม่กุญแจ โดยทั้งโมเลกุลเป้าหมายและลิแกนด์ถือเป็นโครงสร้าง
ที่แข็ง ไม่สามารถเปลี่ยนแปลงในระหว่างการเชื่อมต่อโมเลกุลระหว่างลิแกนด์และโมเลกุลเป้าหมายได้ 
(Fischer, 1894)ต่อมา Koshland ได้เสนอทฤษฎี Induced Fit ในปี 1958 โครงสร้างของโปรตีนและ
ลิแกนด์สามารถเปลี่ยนแปลงหลังจากโปรตีนเชื่อมต่อกับลิแกนด์แล้ว ซึ่งบ่งชี้ว่าโครงสร้างลิแกนด์และ
โปรตีนมีความยืดหยุ่นระหว่างการเชื่อมต่อโมเลกุล (Koshland,1958) เมื่อน าทฤษฎี Induced Fit มา
ปรับใช้กับปฏิสัมพันธ์ระหว่างโมเลกุลยากับโมเลกุลเป้าหมาย ปรากฎว่าผลลัพธ์การเชื่อมต่อลิแกนด์
และโมเลกุลเป้าหมายมีความแม่นย ามาก ซึ่งส าคัญส าหรับการค้นคว้าและพัฒนายา การประเมินการ
เข้าจับกันของโครงสร้างลิแกนด์กับโมเลกุลเป้าหมาย แบ่งได้ 4 แบบ (Meng, X, et al., 2011, Chen, 
G., et al., 2020) ได้แก่  

2.3.1 Molecular mechanics force field based 
      การประเมินพลังงานยึดเหนี่ยวแรงแวนเดอร์วาล และไฟฟ้าสถิตแบบโคลัมบิก 
เช่นเดียวกับพันธะมุมคล้ายพันธะ และการเบี่ยงเบนแรงบิด เพื่อก าหนดความสัมพันธ์ในการเข้าจับ 
ฟังก์ชันการให้คะแนนนี้เป็นการพิจารณาพันธะไฮโดรเจน การละลาย และการมีส่วนร่วมของเอนโทร
ปี โปรแกรมซอฟแวร์ที่นิยมใช้ เช่น AutoDock, DOCK และ GoldScore 
       2.3.2 Empirical methods-based 
       การค านวณพลังงานยึดเหนี่ยวที่สลายตัวเป็นองค์ประกอบของพลังงานหลาย
อย่าง เหมาะส าหรับปฏิสัมพันธ์โครงสร้างผลึกเชิงซ้อนบางประเภท เช่น พันธะไฮโดรเจน ปฏิสัมพันธ์
ของไอออนิก ผลของ hydrophobic และเอนโทรปี โดยค่าคะแนนที่ได้มาจากการค านวณแต่ละ
องค์ประกอบคูณด้วยค่าสัมประสิทธิ์ ซึ่งค่าสัมประสิทธิ์ได้จากการวิเคราะห์การถดถอยของ ligand-
protein complex ที่ทราบค่า binding affinities โปรแกรมซอฟแวร์ที่นิยมใช้ เช่น  LUDI, PLP และ 
ChemScore  
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      2.3.3 Knowledge-based methods-based 
       การประเมินกลุ่มของโครงสร้างผลึกเชิงซ้อนในทางสถิติของลิแกนด์-โปรตีน ช่วย
ให้องค์ประกอบ อะตอม และการจัดกลุ่มฟังก์ชันมีความเป็นไปได้ที่จะแยกออกเป็นคู่ เพ่ือให้ได้ความถี่
ของการสัมผัสระหว่างอะตอมหรือระยะระหว่างลิแกนด์และโปรตีน ยิ่งถ้ามีปฏิสัมพันธ์ที่ดีความถี่ของ

เหตุการณ์ก็จะยิ่งมากขึ้น เหมาะส าหรับปฏิสัมพันธ์แบบ sulphur-aromatic หรือ cation- π แต่ไม่
เหมาะส าหรับปฏิสัมพันธ์ metals หรือ halogens โปรแกรมซอฟแวร์ที่นิยมใช้ เช่น  PMF และ 
DrugScore 
       2.3.4 Consensus Fundamentally 
       เป็นวิธีล่าสุดที่รวมคะแนนที่แตกต่างกันหลายรายการเพื่อประเมินโครงสร้างการ
เชื ่อมต่อต าแหน่งของลิแกนด์ที ่อาจเกิดขึ ้น Consensus scoring มักจะมีการปรับค่า virtual 
screening, and improves the prediction of bound conformations และ poses อย ่างไรก็
ตามการท านายพลังงานอาจจะมีคลาดเคลื่อนนอกจากนี้หากคะแนนที่แตกต่างกันมีความสัมพันธ์กัน
อย่างมีนัยส าคัญ การให้คะแนนด้วยวิธีนี้อาจไม่เหมาะ โปรแกรมซอฟแวร์ที่นิยมใช้ เช่น  CScore 
ร่วมกับ DOCK, ChemScore, PMF, GOLD และ FlexX 
 
2.4 ADMET 
 
      ADMET เป็นทางเลือกใหม่ในการพัฒนายา สามารถคัดกรองยาบนคอมพิวเตอร์ได้ ซึ่ง 
ADMET คือ คุณสมบัติการดูดซึม การกระจาย เมแทบอลิซึม การขับถ่าย และความเป็นพิษของ
โมเลกุลขนาดเล็ก คุณสมบัติ ADMET ที่คาดการณ์ไว้สามารถน ามาใช้ในการคัดแยกสารประกอบที่มี
คุณสมบัติที่ไม่เอื้ออ านวยในช่วงต้นของกระบวนการพัฒนายา ซอฟแวร์ที่นิยมใช้ ได้แก่ AutoDock 
Vina, GOLD, Glide และSchrödinger Suite ช่วยให้สามารถประเมินคุณสมบัติของยาในแง่ของการ
ดูดซึม การกระจายตัวภายในร่างกาย เมแทบอลิซึม การขับถ่าย และความเป็นพิษที่อาจเกิดขึ้นได้
ก่อนที่จะท าการทดลองในระดับต่อไป โดยฐานข้อมูลเกี่ยวกับ ADMET มีมากมาย ต่างกันที่ข้อจ ากัด
ของแต ่ละฐานข ้อม ูล ต ัวอย ่างฐานข ้อม ูล ADMET เช ่น admetSAR (Agarwal, et al., 2023) 
SwissADME (Daina et al., 2017) 
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2.5 งานวิจัยที่เกี่ยวข้อง  
 

    Rahman et al. (2017) รายงานว่า cholinergic activity ที่ลดลงและความเครียดจาก
ปฏิกิริยาออกซิเดชั่นเป็นปัจจัยส าคัญในการเกิดโรคอัลไซเมอร์ ดังนั้นการยับยั้งโคลีนเอสเตอเรสและ
ออกซิเดชั่นจึงเป็นสองวิธีที่มีแนวโน้มในการพัฒนายาส าหรับอัลไซเมอร์ การศึกษานี้ประเมินคุณสมบัติ
ต่าง ๆ ของสารสกัดจากใบ G. pentaphylla ผลการทดลองปรากฏว่ามีศักยภาพในการก าจัดอนุมูล
อิสระและฤทธิ ์ย ับย ั ้ งการเก ิด  lipid peroxidationและยับย ั ้งโคล ีนเอสเตอเรส ซ ึ ่งท  าให้  G. 
pentaphylla มีประสิทธิภาพในการรักษาอัลไซเมอร์ นอกจากนี้สารสกัดยังให้ผลดีต่อการต้าน
แบคทีเรีย   
      Hongwei Chen et al. (2022) สกัดสารจากล าต้นและใบของ Glycosmis ovoidea 
Pierre(ประยงค์ไข่) จากการวิเคราะห์ด้วยสเปกโทรสโกปี 1D และ 2D NMR และ HRESIMS พบว่ามี
สารประกอบ 5 ชนิดมีผลยับยั้งปานกลางต่อการผลิตไนตริกออกไซด์ที่ถูกกระตุ้นโดยไลโปโพลีแซ็กคา

ไรด์ในเซลล์ไมโครเกลีย BV-2 โดยมีค่า IC50 ในช่วง 18.30–30.84 μM และสารประกอบ 3 ชนิด

แสดงการยับยั้งที่มีศักยภาพใน 5-lipoxygenase (5-LOX) ที่มีค่า IC50 ใน ช่วง 2.08–10.26 μM ซึ่ง
สรุปได้ว่าสารสกัดจาก Glycosmis ovoidea Pierre มีฤทธิ ์การต้านการอักเสบในสมอง จากนั้น
วิเคราะห์ต าแหน่งการจับที่เป็นไปได้ของสารประกอบออกฤทธิ ์ที ่มี 5 -LOX ด้วยวิธี molecular 
docking 
     Fatima Javed Mirza et al. (2022) การศึกษานี ้ได้ท าการตรวจสอบศักยภาพในการ
รักษาโรคอัลไซเมอร์ของสารพฤกษเคมีที่มีทั้งสามชนิดของ Rosmarinus officinalis ได้แก่ กรดเออร์
โซลิก (UA), กรดโรสมารินิก (RA) และกรดคาร์โนซิก (CA) โดยใช้วิธีการต่าง ๆ เช่น AutoDock Vina 
และการจ าลองไดนามิกของโมเลกุล (MD) เพ่ือพิจารณาความสัมพันธ์ที่ผูกพันกับโปรตีนที่เกี่ยวข้องกับ
โรคอัลไซเมอร์ ผลการศึกษาแสดงให้เห็นว่า UA และ RA เป็นตัวยับยั้งที่เป็นไปได้ของ AChE และ 
BACE1 และมีพลังงานการจับยึดที่เทียบเคียงได้กับพลังงานของโดเนเพซิลที่ใช้เป็นกลุ่มควบคุมเชิง
บวก 
     V. K. Loganathbabuthasma et al. (2023) โปรตีนเทามีบทบาทส าคัญในโรคอัลไซ
เมอร์ และยาต่าง ๆ ที่มีในตลาดในปัจจุบันไม่เพียงว่ามีราคาแพงมาก แต่ยังมีผลข้างเคียงที่ร่างกาย 
การใช้ยาที่มีอยู่แล้วเป็นวิธีที ่ดีวิธีการวิจัยเริ ่มจากเลือกโมเลกุลสารประกอบจาก Selleckchem 
natural product library และความสามารถของยาในการผ่าน Blood Brain Barrier (BBB) และ
ตรวจสอบคุณสมบัติ ADMET (Absorption, Distribution, Metabolism, Excretion, and Toxicity) 
โดยใช้ SwissADME. โครงสร้างของโปรตีนทาว ถูกดึงมาจาก PDB และท า molecular docking กับ
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สารประกอบโดยใช้ PyRx-Virtual Screening Tool ผลการวิจัยพบว่ามีสารประกอบทั้งหมด 92 ชนิด
ที่ผ่านเกณฑ์คัดกรอง ADMET และพบว่า Ligustroflavone มีค่า binding affinity ดีที่สุดนี้ 
     Ahsas Goyal และ Neetu Agrawal (2023) การศึกษามีวัตถุประสงค์เพื่อระบุฟลาโว

นอยด์ท่ีสามารถจับกับตัวรับ α7nAChR ได้อย่างมีประสิทธิภาพซึ่งมีบทบาทส าคัญในการรักษาโรคอัล
ไซเมอร์ (AD) วิเคราะห์การเชื ่อมต่อโมเลกุลและการจ าลองไดนามิกของโมเลกุลเพื ่อประเมิน
ความสัมพันธ์ในการจับและความเสถียรในการก่อตัวของฟลาโวนอยด์ 50 ตัว โดยที่อะเมนโตฟลาโวน

และกาลโลคาเทชินมีค่าการจับกับ α7nAChR สูงที่สุด 
     Mahfuza Afroz Soma (2019) ศึกษาสารประกอบยาแก้ปวดและต้านการอักเสบที่มีอยู่
ในใบ Glycosmis pentaphylla ผ่านการวิเคราะห์ไฟโตเคมีและการศึกษา in silico docking มีการ
แยกสารประกอบ 9 ชนิด รวมถึง arborinine และ phytol ซึ ่งพบว่าจับกับไซต์แอคทีฟของ 
cyclooxygenase-2 (COX-2) ซึ่งบ่งชี้ถึงศักยภาพในการแก้ปวดและต้านการอักเสบได้ 
     B. G. Rao และ N. J. Raju (2009) ศึกษาการต้านอักเสบของสารสกัดเมทานอลและ
เอทิลแอซีเทตจากรากของ Glycosmis pentaphylla ในหนูเมอร์แอลบิโนวิสตาร์ ผลการต้านอักเสบ
ของสารสกัดเมทานอลและเอทิลแอซีเทตจาก Glycosmis pentaphylla ที่ปริมาณ 200 และ 400 
มิลลิกรัมต่อกิโลกรัม พบว่ามีค่า P < 0.001 แสดงว่าสามารถลดการอักเสบของหนูได้ และใช้ 
Ibuprofen (50 มิลลิกรัมต่อกิโลกรัม) เป็นสารต้านการอักเสบเปรียบเทียบ 
     นภกชมณฑน์ และคณะ (2020) สกัด จ าแนก และทดสอบประสิทธิภาพของสารออกฤทธิ์
ทางชีวภาพที่ส าคัญจากสมุนไพรเขยตาย จากใบ ล าต้น และราก ด้วยวิธีการหมักร่วมกับการใช้คลื่น
ความถี่สูง และ เทคนิค Thin Layer Chromatography จากนั้นศึกษาประสิทธิภาพในการยับยั้ง
แบคทีเรียด้วย Disc Agar diffusion พบสารในกลุ่มอัลคาลอยด์ และมีประสิทธิภาพในการยับยั้งเชื้อ
แบคทีเรีย Escherichia coli และ Staphylococcus aureus  
     ธนพร (2022) ตรวจสอบรูปแบบการจับและอันตรกิริยาระหว่างยารักษาภาวะสมดุลของ
แคลเซียมและยาต้านการอักเสบโปรตีนเป้าหมายของการเกิดโรคอัลไซเมอร์ โดยมียาอัลไซเมอร์ 24 
ชนิด ยารักษาภาวะสมดุลของแคลเซียม 74 ชนิด และยาต้านการอักเสบ 133 ชนิด ได้รับการ
ตรวจสอบเพื่อหารูปแบบการเข้าจับกันที่ดีที่สุดกับโปรตีนเป้าหมาย 55 ชนิดที่สัมพันธ์กับโรคอัลไซ
เมอร์ โดยเทคนิคการเข้าจับกันระดับโมเลกุล อันตรกิริยาของพันธะเชิงซ้อนระหว่างยาและโปรตีนถูก
ระบุผ่านโปรแกรม PLIP ผลการวิจัยพบว่าการเปรียบเทียบแสดงให้เห็นว่า Plicamycin และ 
Talniflumate เป็นยารักษาโรคที่ดีกว่าส าหรับการรักษาโรคอัลไซเมอร์มากกว่า Nirogacestat และ 
BMS-986115 
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บทที ่3 
วธิกีารวจิยั 

 
3.1 อปุกรณ์และโปรแกรมทางชวีสารสนเทศ 

 
      3.1.1 เครื่องคอมพิวเตอร์ Lenovo รุ่น V50a-22IMB ระบบปฏิบัติการ Windows 

       3.1.2 โปรแกรม Avogadro 
      3.1.3 โปรแกรม Maestro 

       3.1.4 โปรแกรม Discovery Studio 
       3.1.5 PrankWeb 

      3.1.6 โปรแกรม AutoDock Tools 
      3.1.7 โปรแกรม Git Bash 
      3.1.8 โปรแกรม PLIP 
      3.1.9 โปรแกรม PyMol 
      3.1.10 โปรแกรม Microsoft Excel 
      3.1.11 โปรแกรม Open Babel GUI 
      3.1.12 โปรแกรม Spyder  
      3.1.13 SwissADME 
      3.1.14 ProTox3 

 
3.2 ฐานขอ้มลูสาธารณะ 

 
      3.2.1 ฐานข้อมูล PubChem (https://pubchem.ncbi.nlm.nih.gov) 
      3.2.2 ฐานข้อมูล UniProt (https://www.uniprot.org) 

       3.2.3 ฐานข้อมูล DrugBank (https://go.drugbank.com) 
       3.2.4 ฐานข้อมูล RCSB Protein Data Bank (https://www.rcsb.org) 
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3.3 การคัดเลือกโครงสร้างของสารออกฤทธิ์ทางชีวภาพในเขยตาย โปรตีนเป้าหมายที่เกี่ยวข้องกับ
โรคอัลไซเมอร์ และโครงสร้างของยา เป็นโครงสร้างสามมิติ 
 
       3.3.1 การคัดเลือกโครงสร้างสามมิติของสารออกฤทธิ ์ทางชีวภาพในเขยตายจาก
ฐานข้อมูล PubChem 
      เข้าสู ่หน้าเว็บของ Pubchem ( https://pubchem.ncbi.nlm.nih.gov/) น า
รายชื่อสารสกัดที่ได้รับความอนุเคราะห์ข้อมูลสารออกฤทธิ์ทางชีวภาพในเขยตายจากงานวิจัยของ นภ
กชมณฑน์ ทหารไทย, อภิชญา ข าปลอด และณัฐนิช เชื้อพลพิชัย มาท าการค้นหาโครงสร้างสามมิติ  
จากนั้นท าการดาวน์โหลดโครงสร้างสามมิติในรูปแบบไฟล์ *.pdb  
       3.3.2 การคัดเลือกโครงสร้างสามมิติของโปรตีนเป้าหมายจากฐานข้อมูล  UniProt 
      ได้รับความอนุเคราะห์ข้อมูลชนิดของโปรตีนเป้าหมาย จากธนพร เตชประภาส
รัตน์  แล้วน ารหัส Uniprot ID ของโปรตีนเป้าหมายเพื่อใช้ในการค้นหาโครงสร้างสามมิติของโปรตีน 
จากนั้นเข้าสู่เว็บของ RCSB PDB ( https://www.rcsb.org/ ) เพ่ือท าการค้นหาโครงสร้างโปรตีนสาม
มิติที่เก่ียวข้องกับยาที่ใช้ในการรักษาโรคอัลไซเมอร์ และท าการดาวน์โหลดไฟล์นามสกุล *.pdb 
       3.3.3 การคัดเลือกข้อมูลยาที่เกี่ยวข้องกับโรคอัลไซเมอร์จากฐานข้อมูล DrugBank 
      ได้รับความอนุเคราะห์ข้อมูลชนิดยาที่เกี ่ยวข้องกับโรคอัลไซเมอร์จาก ธนพร  
เตชประภาสรัตน์ ได้แก่ยาที่ใช้ในการรักษาเกี่ยวกับโรคอัลไซเมอร์ ยาที่เก่ียวข้องกับการอักเสบ และยา
ที่เกี่ยวข้องกับการรักษาสมดุลของแคลเซียมในร่างกาย จากนั้นท าการเข้าสู่เว็บไซต์ของ DrugBank ( 
https://go.drugbank.com/ ) ดาวน์โหลดโครงสร้างสามมิติของยาในรูปแบบไฟล์ *.pdb แต่ถ้ายา
ชนิดไหนที่มีข้อผิดพลาดทางโครงสร้างจะท าการดาวน์โหลดโครงสร้างยาผ่าน ChemSpider เป็น
รูปแบบไฟล์ *.mol หรือ *.mol2 
 
3.4 การเตรียมไฟล์ข้อมูล 
 
       3.4.1 การเตรียมไฟล์ข้อมูลส าหรับสารออกฤทธิ ์ทางชีวภาพในเขยตายและยาที่
เกี่ยวข้องกับโรคอัลไซเมอร์ 
      ใช้ไฟล์โครงสร้างสามมิติที่ได้ท าการดาวน์โหลดมาจากในขั้นตอนก่อนหน้านี้ เริ่ม
จากการปรับโครงสร้างของไฟล์ให้เหมาะสมโดยใช้โปรแกรม Avogadro โดยวิธีการดังนี้ ท าการเปิด
โปรแกรมและเปิดไฟล์โครงสร้าง 3D ผ่าน File > Open > เลือกไฟล์ที่ต้องการ จากนั้นเลือกค าสั่ง 
Extensions > Optimized Geometry และบันทึกไฟล์เป็น ligandname_optimized.pdb จากนั้น
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ใช้โปรแกรม Discovery Studio ในการเพิ่มไฮโดรเจน และการค านวณประจุและบันทึกไฟล์นามสกุล 
*.pdb โดยท าการเปิดโปรแกรมและเปิดไฟล์โครงสร้าง 3D ผ่าน File > Open > เลือกไฟล์ที่ต้องการ 
ข ั ้นต ่อมาเล ือกค  าส ั ่ ง Chemistry > add H, Polar, Chiral ต ่อมาเล ือกเมน ูค  าส ั ่ ง Charge > 
Calculate ส ุ ด ท ้ า ย เ ล ื อ ก เ ม น ู  Structure > Clean Geometry แ ล ะ บ ั น ท ึ ก ไ ฟ ล ์ เ ป็ น 
ligandname_optimized_clean.pdb 
       3.4.2 การเตรียมข้อมูลส าหรับโปรตีนเป้าหมายที่เกี่ยวข้องกับโรคอัลไซเมอร์ 
      ใช้ไฟล์โครงสร้างสามมิติของโปรตีนเป้าหมายที่ได้ท าการดาวน์โหลดมาจาก
ขั้นตอนก่อนหน้านี้ เริ่มจากการปรับโครงสร้างไฟล์ให้เหมาะสมโดยใช้โปรแกรม Maestro เพ่ือท าการ
ตรวจสอบโครงสร้างและเตรียมโครงสร้างไฟล์ให้ถูกต้องเหมาะสมโดยท าการเปิดโปรแกรม Maestro 
เลือก File > Change Working Directory เลือก directory ที่ต้องการท างานและกดปุ่ม Select 
Folder ส ุดท ้ายบ ันท ึกโปรเจคที ่ ใช ้ท  างานด ้วย File > Save Project As > เปล ี ่ยนช ื ่อไฟล์  
projectname.pjr > กดปุ่ม Save เปิดไฟล์โครงสร้างโปรตีนผ่าน File > Import Structure > เลือก
โครงสร้างโปรตีนที่ต้องการปรับโครงสร้างให้เหมาะสม > open > import > เลือกเครื่องมือ protein 
preparation workflow จากแถบเมนู เลือกเมนู Protein Preparation > กดปุ่ม Interactive (On) 
เลือก Specify Protein > Workspace (included entry) > Global Setting > Simulation as pH 
7.4 จากนั ้น check box ด้านหน้า Small molecules ก าหนดตามค่า defaults ของโปรแกรม 
สุดท้ายกดปุ่ม Reviews Structure > เลือกเมนู Preprocess > check box Cap terminal และ fill 
in missing side chains จากนั้นเลือก more options > checked box ตามค่า defaults และกด
ปุ่ม Preprocess > เลือกเมนู Diagnose and Analyze > กดปุ ่ม Check Structure ถัดมาเลือก 
Substructure tab พิจารณา Ligand, Water, และ Chain ที่ไม่ต้องการเลือกและกดปุ่ม Delete 
from Entry จากนั ้นเล ื ่อนไปยัง Diagnostics tab พิจารณา Valences, Missing, และ Reports 
ส ุดท ้ายกล ับไปย ัง workflows > เล ือกเมน ู Optimized and H-bond assignment > กดปุ่ม 
Settings ก าหนดค่าตาม defaults ตามที ่โปรแกรมตั ้งไว้ สุดท้ายกดปุ ่ม optimize และบันทึก
โครงสร้างโปรตีนผ่าน File > Export Structure > บันทึกเป็น proteinname_optimized.pdb 
จากนั้นใช้โปรแกรม Discovery Studio ในการเพิ่มไฮโดรเจน และการค านวณประจุและบันทึกไฟล์
นามสกุล *.pdb ตามข้ันตอนที่ 3.4.1 
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3.5 การท านายบริเวณเข้าจับกับสารออกฤทธิ์ทางชีวภาพในเขยตายและยา ในโปรตีนเป้าหมายและ
ต าแหน่งเร่งปฏิกิริยาบนโครงสร้างสามมิติของโปรตีน 
 
       น าโปรตีนที ่ได้จากขั ้นตอนก่อนหน้าในรูปแบบของไฟล์ *.pdb มาท าการท านาย
ต าแหน่งการเข้าจับกับสารตั้งต้นผ่าน PrankWeb (https://prankweb.cz) โดยการเลือก custom 
structure > choos file เลือกไฟล์ที่ต้องการท านายบริเวณเข้าจับ จากนั้นกด Submit สุดท้ายดาวน์
โหลดไฟล์ ซึ่งประกอบด้วยไฟล์หลัก 2 ไฟล์ ได้แก่ ไฟล์ structure.pdb_prediction.csv (เปิดผ่าน
โปรแกรม Microsoft Excel แสดงผลของจ านวนต าแหน่งที่เข้าจับสารตั้งต้นของโปรตีนและพิกัด 
(center x, center y และ center z) ของต  าแหน ่งท ี ่สารต ั ้ งต ้นเข ้าจ ับก ับโปรต ีน และไฟล์  
structure.pdb_residues.csv (เปิดผ่านโปรแกรม Microsoft Excel) แสดงผลของต าแหน่ง และ
ชนิดของกรดอะมิโนที่ปรากฏในแต่ละต าแหน่งของบริเวณที่เข้าจับกับโปรตีน 
 
3.6 การเตรียมไฟล์ส าหรับการจ าลองการเข้าจับกันของโมเลกุล (Molecular docking) 
 
       3.6.1 การเตรียมไฟล์ข้อมูลส าหรับสารออกฤทธิ ์ทางชีวภาพในเขยตายและยาที่
เกี่ยวข้องกับโรคอัลไซเมอร์ 
      ใช้โปรแกรม Autodock tools ในการเตรียมไฟล์ออกมาเป็นไฟล์นามสกุล 
*.pdbqt เพ่ือเตรียมส าหรับการทดสอบการเข้าจับกับโปรตีน ดังนี้ 
       Ligand > input > Open > OK 
       Ligand > Torsion Tree > Choose Torsion > Done 
       Ligand > Torsion Tree > Detect Root 
       Ligand > Output > Save as PDBQT > บันทึกเป็น X.pdbqt  
               (X คือ ล าดับของลิแกนด์) 
        3.6.2 การเตรียมไฟล์ข้อมูลส าหรับโปรตีนเป้าหมายที่เกี่ยวข้องกับโรคอัลไซเมอร์ 

    ใช้โปรแกรม Autodock tools ในการเตรียมไฟล์ออกมาเป็นไฟล์นามสกุล  
*.pdbqt เพ่ือเตรียมส าหรับการทดสอบการเข้าจับกับโปรตีน ดังนี้ 
   File > Read Molecule > เลือกไฟล์โปรตีน > Open 
   คลิก Cl ในช่องของ Dashboard > By atom type > Close 
   Select > Select from string > ช่อง residues พิมพ์ HOH*, ช่อง atom  
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        พิมพ์ * > Add > Dismiss (ถ้ามีโมเลกุลน ้าที่เป็นจุดสีเหลืองให้ท า Edit >                   
                           Delete > Delete selected atoms > Continue) 
   เลือก Edit > Hydrogens > Add > Polar only > OK 
   Grid > Macromolecule > Choose > เลือกโปรตีน > Select Molecule  
                           > OK > บันทึกไฟล์ modelX.pdbqt (X คือ เลขของโปรตีน) 

ก าหนดค่า center x, y, z ตาม prankweb และ Dimension x, y, z คือ      
    40, 40, 40 

3.7 ขั้นตอนในการท า Multiple Molecular Docking 
 

      เป็นขั ้นตอนที่ใช้ในการท า Binding Affinity Energy ด้วย Autodock Vina โดยจะ
ท างานผ่านโปรแกรม Git Bash โดยในขั้นตอนนี้จะประกอบไปด้วยไฟล์ ดังนี้ 

(1) ไฟล์โปรตีนเป้าหมาย (ไฟล์นามสกุล *.pdbqt) 
(2) ไฟล์โครงสร้างสามมิติของยา (ไฟล์นามสกุล *.pdbqt) 
(3) ไฟล์โครงสร้างสามมิติของสารออกฤทธิ์ทางชีวภาพในเขยตาย (ไฟล์นามสกุล  

*.pdbqt) 
(4) ไฟล์ก าหนดค่า (configuration file) หรือ config_j.txt (j คือ ไฟล์ของโปรตีน 

เป้าหมาย 
(5) ไฟล์ vina.exe 
(6) ไฟล์ vina_license.rtf 
(7) ไฟล์ vina_split.exe 

 
ภาพที่ 3.1 แสดงตัวอย่างการก าหนดค่าในไฟล์ config_j.txt 
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      ขั้นตอนแรกของการท างานจะต้องเปลี่ยนไดเรกเทอรีไปที่โฟลเดอร์ที่เก็บข้อมูล และ
พิมพ์ค าสั่งเรียก Autodock vina จากนั้นก าหนดค่าให้ j=1 สุดท้ายพิมพ์ค าสั่งเพ่ือให้ Autodock 
vina ท างานโดยใช้ไฟล์ที่ก าหนดค่าตัวเลข ดังนี้ 
   $ cd     ค าสั่งเปลี่ยนไดเรกเทอรี 
   $ ./vina --help         ค าสั่งเรียก Autodock vina 
   $ j=1    ค าสั่งก าหนดค่า j=1 
   $ for j in {1..3} ; do for i in {101..105} ; do ./vina --receptor 
$j.pdbqt --ligand $i.pdbqt --config config_$j.txt --out ${j}_$i.pdbqt --log ${j}_$i.log ; 
done ; done 
(j คือ ไฟล์ของโปรตีนเป้าหมาย และ i คือ ไฟล์ของยา) ค าสั่งให้ Autodock vina ท างาน 
       เมื่อสิ้นสุดการประมวลผลจะได้ไฟล์ 2 ไฟล์ คือ ไฟล์นามสกุล *.log เป็นไฟล์ที่เก็บ
ตารางข้อมูลค่าพลังงานของการเข้าจับกันของโปรตีนและลิแกนด์ และไฟล์นามสกุล *.pdbqt เป็น
ไฟล์โครงสร้างของลิแกนด์ที่มีการเข้าจับกับต าแหน่งของโปรตีน 
       ซึ่งในการทดสอบการเข้าจับกันระหว่างสารออกฤทธิ์ทางชีวภาพในเขยตายและยากับ
โปรตีนเป้าหมายของการเกิดโรคอัลไซเมอร์จะถูกท าซ ้าคู่ละ 3 ซ ้า โดยจะเลือก pocket ที่ดีที่สุดของ
ทุกโปรตีน แล้วท าการเลือกค่าพลังงานการยึดเกาะที่ดีที่สุดส าหรับใช้ในการรายงานผลและน าไป
วิเคราะห์อันตรกิริยาในขั้นตอนต่อไป 
 
3.8 การแสดงผลของการทดสอบการเขา้จบัระหวา่งสารออกฤทธิท์างชวีภาพในเขยตายและยากบั
โปรตนีเปา้หมายของการเกิดโรคอลัไซเมอร ์และการวเิคราะหอ์นัตรกริยิา 
 
       น าไฟล์โครงสร้างลิแกนด์ที่เข้าจับกับโปรตีนเป้าหมายนามสกุล *.pdbqt ที่ได้จากการ
ท า Multiple Molecular Docking มาเปิดในโปรแกรม Discovery Studio จากนั้นบันทึกไฟล์ของลิ
แกนด์ที่ให้ค่าพลังงานการเข้าจับที่ดีที่สุดเป็นนามสกุล *.pdb ต่อมาน าไฟล์ที่ได้และไฟล์ของโปรตีน
นามสกุล *.pdbqt ที่ได้จากขั้นตอนที่ 3.3.2 มาเปิดในโปรแกรม PyMol เพื่อแสดงผลเป็นภาพของลิ
แกนด์ที่เข้าจับกับโปรตีนในต าแหน่งที่มีค่าพลังงานการเข้าจับที่ดีที่สุด แล้วบันทึกไฟล์นามสกุล *.pdb 
จากนั้นบันทึกภาพโดยเลือกรูปแบบ ray trace with transparent background เป็นไฟล์ *.png 
       ต่อมาท าการแปลงไฟล์ *.pdb ที่ได้จากโปรแกรม PyMol ผ่านโปรแกรม Open Babel 
GUI โดยจะมีการเพิ ่ม HETATM, CONECT, ENDML, MODEL และ REMARK เพื ่อเป ็นการจัด
ระเบียบของไฟล์ 
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       สุดท้ายน าไฟล์นามสกุล *.pdb ที่ได้จากโปรแกรม Open Babel GUI ไปวิเคราะห์อันตร
กิริยาผ่าน PLIP (https://plip-tool.biotec.tu-dresden.de/plip-web/plip/index) จากนั้นดาวน์
โหลดไฟล์แสดงผลการวิเคราะห์อันตรกิริยาที่อยู่ในรูปแบบของไฟล์นามสกุล *.png,*.pse และ *.RST 
 
3.9 การท านายคุณสมบัตทิางเภสชัวทิยาของสารออกฤทธิท์างชวีภาพในเขยตายและยา 
 
       น าโครงสร้างของสารออกฤทธิ์ทางชีวภาพในเขยตายและยาไปท านายคุณสมบัติทาง
เภสัชวิทยาผ่าน SwissADME (http://www.swissadme.ch) เพ่ือใช้ในการพิจารณาค่าคุณสมบัติการ
ดูดซึม, การกระจายตัว, เมแทบอลิซึม และการขับออกของสาร โดยพิจารณาค่าความเหมือนยา (Drug 
likeness) ตามกฎเกณฑ์ของลิปินสกี้ (Lipinski’ rule) จากนั้นท านายความเป็นพิษด้วย Protox3 
(https://tox.charite.de/protox3) โดยจ าแนกความเป็นพิษออกเป็น 6 ประเภทตาม Globally 
Harmonized System of Classification and Labelling of Chemicals (GHS) 
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บทที ่4 
ผลการวจิัยและอภปิรายผล 

 
4.1 การคัดเลือกโครงสร้างสามมิติ  
      

      ผลการคัดเลือกโครงสร้างสามมิติของสารออกฤทธิ์ทางชีวภาพในเขยตาย 40 ชนิด 
โปรตีนเป้าหมายที่เก่ียวข้องกับโรคอัลไซเมอร์ 46 ชนิด และยาควบคุมเชิงบวกที่ใช้ในการรักษาโรคอัล
ไซเมอร์ 23 ชนิด 

ตารางที ่4.1 การคัดเลือกโครงสร้างสามมิติ 

ขอ้มลูโครงสร้างสามมติิ ฐานขอ้มลู จ านวนขอ้มลู 
โปรตีนเป้าหมายที่เก่ียวข้องกับโรคอัลไซเมอร์ Protein Data Bank 46 

สารออกฤทธิ์ทางชีวภาพของเขยตาย PubChem 40 

ยาที่ใช้ในการรักษาโรคอัลไซเมอร์ DrugBank 23 

 
4.2 การท านายบริเวณเข้าจับในโปรตีนเป้าหมาย 
 

    การท านายบริเวณเข้าจับของสารตั้งต้นในโปรตีนเป้าหมายที่เกี่ยวข้องกับโรคอัลไซเมอร์ 
และต าแหน่งเร่งปฏิกิริยาบนโครงสร้างสามมิติของโปรตีน ด าเนินการผ่านโปรแกรม PrankWeb โดย
เลือกฉพาะบริเวณเข้าจับที่ 1 (pocket1) ซึ่งมีความน่าจะเป็นสูงสุดที่สารตั้งต้นสามารถเข้าจับได้ดี 

ตารางที ่4.2 บริเวณเข้าจับที่ 1 ของโปรตีนเป้าหมายที่เกี่ยวข้องกับโรคอัลไซเมอร์ 
Uniport 

ID 
ชือ่โปรตนี คะแนน 

ความ
นา่จะเปน็ 

CenterX Center Y Center Z 

P28222 5-hydroxytryptamine 1 26.66 0.896 -10.6932 -18.523 20.8911 
P28221 5-hydroxytryptamine 1D 13.48 0.706 95.4102 121.2583 119.8157 

P28566 5-hydroxytryptamine 1E 26.43 0.894 92.0758 121.4461 118.1679 
P47898 5-hydroxytryptamine 2A 37.85 0.951 -28.4837 -11.6837 144.2661 

P41595 5-hydroxytryptamine 2B 28.65 0.909 21.8315 17.706 9.7313 

P28335 5-hydroxytryptamine 2C 31.01 0.922 38.5373 31.658 58.1946 
P46098 5-hydroxytryptamine 3A 8.18 0.48 -19.2036 3.7808 5.1224 
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P47898 5-hydroxytryptamine 5A 19.01 0.825 -18.3057 11.6365 7.7531 

P50406 5-hydroxytryptamine 6 22.42 0.863 119.5188 80.1896 125.1869 
P34969 5-hydroxytryptamine 7 29.27 0.913 90.2812 108.6963 79.7726 

P08909 5-hydroxytryptamine_1C 32.72 0.931 4.4003 5.8248 -8.899 

P22303 Acetylcholinesterase 19.9 0.837 120.8025 109.2585 -134.119 
P35348 Alpha-1A adrenergic 15.67 0.763 -9.787 -5.1005 3.5178 

P35368 Alpha-1B adrenergic 11.72 0.65 -2.7271 -0.5105 12.9156 

P25100 Alpha-1D adrenergic 15.13 0.751 -1.6248 9.0258 -14.0938 
P08913 Alpha-2A adrenergic 23.05 0.869 -3.2643 -6.908 -20.3163 

P18089 Alpha-2B adrenergic 38.06 0.952 119.2908 114.0578 84.1071 
P18825 Alpha-2C adrenergic 23.44 0.872 -9.8319 4.7879 56.9687 

P08588 Beta adrenergic 29.9 0.916 21.4457 -22.2271 79.4869 

P07550 Beta2 adrenergic 17.54 0.802 -4.1435 -11.7452 -50.6396 
P06276 Cholinesterase 31.43 0.924 -18.5369 -27.2199 42.5243 

P41143 Delta-type opioid 11.4 0.637 -5.5717 -69.1266 72.2846 

P21728 Dopamine D1 24.44 0.88 96.653 111.0993 130.4318 
P35462 Dopamine D3 24.09 0.877 5.9937 14.5852 -10.0987 

P21917 Dopamine D4 21.15 0.85 -17.5211 16.4957 -18.1661 
P21918 Dopamine D5 20.68 0.846 7.8182 3.9878 -8.8417 

Q96BI3 
Gamma-secretase  
subunit APH-1A 

23.67 0.874 201.6462 161.1457 155.7879 

Q9NZ42 
Gamma-secretase  

subunit PEN-2 
22.69 0.866 202.2062 160.2734 154.1679 

P23415 Glycine 23.48 0.873 -31.0097 -15.3402 11.8389 

P35367 Histamine H1 21.73 0.856 17.5427 35.5253 18.0914 

P25021 Histamine H2 14.41 0.732 159.2549 163.0322 199.3963 
Q9Y5N1 Histamine H3 12.97 0.691 -20.1906 51.0283 -0.0825 

Q9H3N8 Histamine H4 8.77 0.516 -8.9551 -6.3757 12.9668 
P01584 Interleukin-1 beta 1.81 0.033 40.799 22.9965 64.4443 

P41145 Kappa-type opioid 22.24 0.861 106.7776 105.9213 70.0645 
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Q01959 
Sodium dependent 

serotonin_transporter 
24.65 0.881 -36.6181 -19.4132 2.9665 

P08172 
Muscarinic acetylcholine 

receptor M2 
29.49 0.914 181.9727 27.941 522.3483 

P20309 
Muscarinic acetylcholine 

receptor M3 
17.5 0.801 125.7122 117.8551 159.3143 

P08173 
Muscarinic acetylcholine 

receptor M4 
34.83 0.94 55.564 -1.703 77.7332 

P08912 
Muscarinic acetylcholine 

receptor M5 
30.34 0.918 34.7702 24.6932 -37.4004 

P35372 Mu-type opioid 50.23 0.976 168.838 161.0317 171.9736 

Q9Y6K9 
NF-kappa-B essential 

modulator 
6.96 0.394 38.513 -50.0448 0.0581 

P29475 
Nitric oxide synthase 

brain 
110.72 0.998 117.3488 246.879 356.6446 

P19838 
Nuclear_factor_NF-

kappa-B 
2.11 0.048 11.1113 -55.1307 6.4156 

Q12809 
Potassium voltagegated 

channel subfamilyH 
member_2 

5.3 0.262 106.8759 59.0542 64.7073 

P31645 
Sodium-dependent 

dopamine_transporter 
13.58 0.709 2.4813 2.7463 -2.0095 

 
4.3 การทดสอบการเข้าจับกันระหว่างโมเลกุล (Molecular docking)   
      

      จากการทดสอบการเข้าจับกันระหว่างโมเลกุลด้วยโปรแกรม Autodock Vina โดย 
ลิแกนด์ คือ สารออกฤทธิ์ทางชีวภาพในเขยตาย 40 ชนิด และยาควบคุมเชิงบวกที่ใช้ในการรักษา
โรคอัลไซเมอร์ 23 ชนิดกับโปรตีนเป้าหมายที่เกี่ยวข้องกับการเกิดโรคอัลไซเมอร์ 46 ชนิด แสดงผล
การจ าลองการเข้าจับกันเชิงโมเลกุล โดยก าหนดให้ค่าพลังงานการยึดเกาะ  (Binding Affinity) ที่ดี
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ที่สุดมีค่าเข้าใกล้สีแดง (-12.00 กิโลแคลอรี่ต่อโมล) ในขณะที่ก าหนดให้ค่าพลังงานการยึดเกาะที่แย่
ที่สุดมีค่าเข้าใกล้สีชมพูเข้ม (-2.00 กิโลแคลอรี่ต่อโมล) ดังภาพที่ 4.1 

 

 
ภาพที่ 4.1 scatterplot 3D ของพลังงานการยึดเกาะระหว่างลิแกนด์และโปรตีนเป้าหมาย โดยแกน  

X, Y และ Z คือ ลิแกนด์ โปรตีน และค่าพลังงานการยึดเกาะ ตามล าดับ ลิแกนด์ 1-40 คือ สารออก 
ฤทธิ์ทางชีวภาพในเขยตาย และลิแกนด์ 41-63 คือ ยาควบคุมเชิงบวก 

      ยาควบคุมเชิงบวก 4 ชนิด ที่ได้รับการขึ้นทะเบียนจาก FDA ให้ใช้รักษาโรคอัลไซเมอร์
ในปัจจุบัน ได้แก่ Donepezil, Galantamine, Rivastigmine และ Tacrine ซึ่งมีโปรตีนเป้าหมาย 2 
ชนิดที่ส าคัญต่อการเกิดโรคอัลไซเมอร์ตามทฤษฎี Cholinergic ได้แก่ Acetylcholinesterase และ 
Cholinesterase ผลการทดลองการเข้าจับของยาต่อโปรตีนเป้าหมายข้างต้น ตามตารางที่ 4.3 และ
ค ัด เล ือกผลการทดลองการเข ้ าจ ับของสารออกฤทธ ิ ์ทางช ีวภาพในเขยตายต ่อโปรตีน  
Acetylcholinesterase ดังตารางที่ 4.4 โดยก าหนดเกณฑ์การคัดเลือก คือ มีพลังงานยึดเกาะดีกว่า
หรือเท่ากับพลังงานการยึดเกาะต่อโปรตีน  Acetylcholinesterase ของยา Rivastigmine ซึ ่งมี
พลังงานการยึดเกาะเท่ากับ -6.2 กิโลแคลอรี่ต่อโมล เป็นพลังงานที่แย่ที่สุดในการยึดเกาะกับโปรตีน 
Acetylcholinesterase เมื่อเทียบกับยาควบคุมเชิงบวก 4 ชนิดข้างต้น และคัดเลือกผลการทดลอง
การเข้าจับของสารออกฤทธิ์ทางชีวภาพในเขยตายต่อโปรตีน Cholinesterase ดังตารางที่ 4.5 โดย
ก าหนดเกณฑ์การคัดเล ือก คือ มีพลังงานดีกว ่าหรือเท่ากับพลังงานการยึดเกาะต่อโปรตีน 
Cholinesterase ของยา Rivastigmine ซึ่งมีพลังงานการยึดเกาะเท่ากับ -7.7 กิโลแคลอรี่ต่อโมล เป็น
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คะแนนที่แย่ที่สุดในการยึดเกาะกับโปรตีน Cholinesterase เมื่อเทียบกับยาควบคุมเชิงบวก 4 ชนิด
ข้างต้น  

ตารางที่ 4.3 พลังงานการยึดเกาะของยาควบคุมเชิงบวกต่อโปรตีน Acetylcholinesterase และ 
Cholinesterase 

ยาควบคุมเชงิ
บวก 

โครงสรา้ง  
โมเลกลุ 

พลงังานการยดึเกาะตอ่โปรตนี
Acetylcholinesterase 

(กโิลแคลอรีต่อ่โมล) 

พลงังานการยดึเกาะตอ่
โปรตนีCholinesterase 

(กโิลแคลอรีต่อ่โมล) 

Donepezil 
 

-7.8 -9.6 

Galantamine 
 

-7.0 -8.7 

Rivastigmine 
 

-6.2 -7.7 

Tacrine 
 

-7.6 -10.5 

ตารางท ี ่  4.4 พล ังงานการย ึด เกาะของสารออกฤทธ ิ ์ทางช ีวภาพในเขยตายต ่อโปรตีน   
Acetylcholinesterase เมื่อเทียบกับคะแนนการยึดเกาะของยา Rivastigmine (พลังงานการยึดเกาะ 
-6.2 กิโลแคลอรี่ต่อโมล) 

สารออกฤทธิ์ทางชวีภาพในเขยตาย 
โครงสรา้ง  
โมเลกลุ 

พลงังานการยดึเกาะ (>= -6.2) 
(กโิลแคลอรีต่อ่โมล) 

1-Methoxy-3-methyl-9H-
carbazole 

 
-8.5 

3-Methoxy-1,2-dimethyl-9H-
carbazol-4-one  

-8.3 

Alpha-phenylindole 
 

-8.2 
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Phytol 
 

-7.4 

beta-Sesquiphellandrene 
 

-7.4 

Linoleic acid 
 

-7.4 

Octadecanoic acid  -7.3 

Zingiberene 
 

-7.2 

Gamma-Muurolene 
 

-7.0 

9,12,15-Octadecatrien  -7.0 

9,17-Octadecadienal  -7.0 

Cytidine 
 

-6.9 

Methyl palmitate  -6.8 

n-Hexadecanoic acid  -6.7 

Vitamin e 
 

-6.7 

Hexadecanoic acid, methyl ester  -6.6 
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3-Indazolone 
 

-6.6 

Bicyclogermacrene 
 

-6.6 

Thioanthranilic acid 
 

-6.5 

2,3,6-Trimethylphenol 
 

-6.4 

1-Heptadecane  -6.2 

Gamma-Pyronene 
 

-6.2 

ตารางที่ 4.5 พลังงานการยึดเกาะของสารออกฤทธิ์ทางชีวภาพในเขยตายต่อโปรตีน Cholinesterase  
เมื่อเทียบกับคะแนนการยึดเกาะของยา Rivastigmine (พลังงานการยึดเกาะ -7.7 กิโลแคลอรี่ต่อโมล) 

สารออกฤทธิ์ทางชวีภาพในเขยตาย 
โครงสรา้ง  
โมเลกลุ 

พลงังานการยดึเกาะ (>= -7.7) 
(กโิลแคลอรีต่อ่โมล) 

Vitamin E 
 

-9.3 

3-Methoxy-1,2-dimethyl-9H-
carbazol-4-one 

 
-9.2 

Alpha-phenylindole 
 

-8.3 

1-Methoxy-3-methyl-9H-carbazole 
 

-8.0 

      จากผลการทดลองการเข้าจับของสารออกฤทธิ ์ทางชีวภาพในเขยตายต่อโปรตีน
เป้าหมายAcetylcholinesterase ดังตารางที่ 4.4 เปรียบเทียบกับยาควบคุมเชิงบวก 4 ชนิด ได้แก่ 
Donepezil Galantamine Rivastigmine และ Tacrine ดังตารางที่ 4.3 พบว่ามีสารในเขยตาย 3 
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ชนิดที่มีพลังงานการยึดเกาะดีกว่ายา Donepezil คือ 1-Methoxy-3-methyl-9H-carbazole, 3-
Methoxy-1,2-dimethyl-9H-carbazol-4-one และ Alpha-phenylindole ค่าพลังงานการยึดเกาะ
เท่ากับ -8.5 -8.3 และ -8.2 กิโลแคลอรี่ต่อโมล ตามล าดับ สารในเขยตาย 11 ชนิดที่มีพลังงานการยึด
เ ก า ะ ดี ก ว ่ า ย า  Galantamine ค ื อ  1 -Methoxy-3 -methyl-9H-carbazole, 3-Methoxy-1,2-
dimethyl-9H-carbazol-4-one, Alpha-phenylindole, beta-Sesquiphellandrene, Phytol, 
Linoleic acid, Octadecanoic acid, Zingiberene, Gamma-Muurolene, 
9,12,15Octadecatrien และ 9,17-Octadecadienal ค่าพลังงานการยึดเกาะเท่ากับ -8.5 -8.3 -8.2 
-7.4 -7.4 -7.4 -7.3 -7.2 -7.0 -7.0 และ -7.0 กิโลแคลอรี่ต่อโมล ตามล าดับ สารในเขยตาย 22 ชนิด
ท ี ่ ม ี พ ล ั ง ง า น ก า ร ย ึ ด เ ก า ะ ดี ก ว ่ า ย า  Rivastigmine ค ื อ  1 - Methoxy-3 - methyl-9 H- 
carbazole, 3-Methoxy-1,2-dimethyl-9H-carbazol-4-one, Alpha-phenylindole, Phytol, 
betaSesquiphellandrene, Linoleic acid, Octadecanoic acid, Zingiberene, 9,17-
Octadecadienal, 9,12,15-Octadecatrien, Gamma-Muurolene, Cytidine, Methyl 
palmitate, n-Hexadecanoic acid, Vitamin E, Hexadecanoic acid-methyl ester,  
3-Indazolone, Bicyclogermacrene, Thioanthranilic acid, 2,3,6-Trimethylphenol, 1-
Heptadecane และ Gamma-Pyronene ค่าพลังงานการยึดเกาะเท่ากับ -8.5, -8.3, -8.2, -7.4, -
7.4, -7.4, -7.3, -7.2, -7.0, -7.0, -7.0 -6.9 -6.8 -6.7 -6.6 -6.6 -6.6 -6.5 -6.4 -6.2 และ  -6.2 ก ิ โล
แคลอรี่ต่อโมล ตามล าดับ และพบว่าสารในเขยตาย 3 ชนิดที่มีพลังงานการยึดเกาะดีกว่ายา Tacrine 
คือ 1-Methoxy-3-methyl-9H-carbazole, 3-Methoxy-1,2-dimethyl-9H-carbazol-4-one และ 
Alpha-phenylindole ค่าพลังงานการยึดเกาะเท่ากับ -8.5, -8.3, และ -8.2 กิโลแคลอรี ่ต่อโมล 
ตามล าดับ 

    จากผลการทดลองการเข้าจับของสารออกฤทธิ์ทางชีวภาพในเขยตายต่อโปรตีนเป้าหมาย 
Cholinesterase ดังตารางที ่ 4.4 เปรียบเทียบกับยาควบคุมเชิงบวก 4 ชนิด ได้แก่ Donepezil 
Galantamine Rivastigmine และ Tacrine ดังตารางที่ 4.3 พบว่าสารในเขยตาย 2 ชนิดที่มีพลังงาน
การย ึ ด เกาะ ดีกว ่ าย า  Galantamine ค ื อ  Vitamine E และ 3-Methoxy-1,2-dimethyl-9H-
carbazol-4-one ค่าพลังงานการยึดเกาะเท่ากับ -9.3 และ -9.2 กิโลแคลอรี่ต่อโมล ตามล าดับ สารใน
เขยตาย 4 ชนิดที่มีพลังงานการยึดเกาะดีกว่ายา Rivastigmine คือ Vitamine E, 3-Methoxy-1,2-
dimethyl-9H-carbazol-4-one, Alpha-phenylindole แ ล ะ  1 - Methoxy-3 - methyl-9 H-
carbazole ค่าพลังงานการยึดเกาะเท่ากับ -9.3 -9.2 -8.3 และ -8 กิโลแคลอรี่ต่อโมล ตามล าดับ และ
พบว่าไม่มีสารในเขยตายที่มีพลังงานการยึดเกาะดีกว่ายา Donepezil และ Tacrine โดยการเข้าจับ
ของสารในเขยตายต่อโปรตีน Cholinesterase ดีที่สุดคือ 3-Methoxy-1,2-dimethyl-9H-carbazol-
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4-one ค่าพลังงานการยึดเกาะเท่ากับ -9.2 กิโลแคลอรี่ต่อโมล ซึ่งมีค่าใกล้เคียงกับการเข้าจับของ  
Donepezil และ Tacrine ต่อโปรตีน Cholinesterase ค่าพลังงานการยึดเกาะเท่ากับ -9.6 และ -
10.5 กิโลแคลอรี่ต่อโมล ตามล าดับ  

ตารางที่ 4.6 แสดงค่าพลังงานการยึดเกาะของสารออกฤทธิ์ทางชีวภาพในเขยตายที่ดีที่สุด และยา
ควบคุมเชิงบวกเม่ือจับกับโปรตีนเป้าหมาย Acetylcholinesterase และ Cholinesterase 

ชือ่โปรตนีเป้าหมาย 
ประเภทของลิ

แกนด ์
ชือ่ของลแิกนด ์

ค่าพลงังานการยดึ
เกาะ 

(กโิลแคลอรีต่อ่โมล) 

Acetylcholinesterase 

สารออกฤทธิ์ทาง
ชีวภาพในเขยตาย 

1-Methoxy-3-methyl-
9H-carbazole 

-8.5 

ยาควบคุมเชิงบวก 

Donepezil -7.8 

Galantamine -7 

Rivastigmine -6.2 

Tacrine -7.6 

Cholinesterase 

สารออกฤทธิ์ทาง
ชีวภาพในเขยตาย 

3-Methoxy-1,2-
dimethyl-9H-carbazol-

4-one 
-9.2 

ยาควบคุมเชิงบวก 

Donepezil -9.6 

Galantamine -8.7 

Rivastigmine -7.7 

Tacrine -10.5 
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     4.3.1 ผลกา ร เข ้ า จ ั บขอ งสา ร  1 -Methoxy-3 -methyl-9H-carbazole แ ละยา 
Donepezil, Galantamine, Rivastigmine, Tacrine ต่อโปรตีน Acetylcholinesterase 

 
ภาพที่ 4.2 โครงสร้างโมเลกุลการเข้าจับของสารออกฤทธิ์ 1-Methoxy-3-methyl-9H-carbazole  
(สีแดง) และยา Donepezil(สีน ้าเงิน) Galantamine(สีเหลอืง) Rivastigmine(สีม่วง) Tacrine(สีส้ม)
ต่อโปรตีนเป้าหมาย Acetylcholinesterase (สีเขียว)  

      จากภาพที ่ 4.2 จะเห็นได้ว ่าสารออกฤทธิ ์ในเขยตาย 1-Methoxy-3-methyl-9H-
carbazole เข้าจับในบริเวณที่แตกต่างจากยาควบคุมเชิงบวก โดยที่สารออกฤทธิ์ 1 -Methoxy-3-
methyl-9H-carbazole มีค่าพลังงานการยึดเกาะกับโปรตีน Acetylcholinesterase ดีที ่สุดหาก
เทียบกับสารออกฤทธิ์ทางชีวภาพในเขยตายทั้งหมด และดีกว่ายาควบคุมเชิงบวกทั้ง 4 ชนิด ได้แก่ 
Donepezil, Galantamine, Rivastigmine, และ Tacrine แสดงให้เห็นว่า 1-Methoxy-3-methyl-
9H-carbazole สามารถเข้าจับกับโปรตีน Acetylcholinesterase ได้ดีกว่ากว่ายาควบคุมเชิงบวกท้ัง 
4 ชนิด 

      จากการศึกษาพบว่า ยา Donepezil, Galantamine, Rivastigmine, และ Tacrine 
เป็นยายับยั้งโปรตีน Acetylcholinesterase ในสมองที่เฉพาะเจาะจง ซึ่ง Acetylcholinesterase 
เป็นที่สามารถสลายสารสื่อประสาท Acetylcholine ได้เป็น acetate ions และ choline ส่งผลต่อ
ระบบประสาทและสมอง เป็นสาเหตุของการเกิดโรคอัลไซเมอร์หรือความจ าเสื่อมได้ เกี่ยวข้องกับการ
ท างานของ Cholinergic และยังเป็นเป้าหมายส าคัญของยาส่วนใหญ่ที่ใช้รักษาโรคอัลไซเมอร์ อีกทั้ง
การศึกษาทางชีวเคมีระบุว่า Acetylcholinesterase กระตุ้นให้เกิดการก่อตัวของอะไมลอยด์ และ
ก่อให้เกิดสารประกอบเชิงซ้อน AChE-Ap ที่เป็นพิษต่อระบบประสาทมากกว่า Ap peptide เพียง
อย่างเดียว แสดงให้เห็นว่าสารยับยั้ง Acetylcholinesterase ที่จ าเพาะอาจให้ผลดีต่อการรักษา
โรคอัลไซเมอร ์ (Gabriella Marucci, et al., 2021, Nibaldo, et al., 2005, Mridula Saxena et 
al., 2019)  
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      4.3.2 ผลการเข้าจบัของสาร 3-Methoxy-1,2-dimethyl-9H-carbazol-4-one และยา 
Donepezil Galantamine Rivastigmine Tacrine ต่อโปรตีน Cholinesterase 

 
ภาพที่ 4.3 โครงสร้างโมเลกุลการเข้าจับของสารออกฤทธิ์ 3-Methoxy-1,2-dimethyl-9H-carbazol-
4-one (สีน ้าตาล) และยา Galantamine(สีเหลือง) Rivastigmine(สีม่วง) ต่อโปรตีนเป้าหมาย 
Cholinesterase (สีเขียว)  

      จากภาพที่ 4.3 จะเห็นได้ว่าสารออกฤทธิ์ในเขยตาย 3-Methoxy-1,2-dimethyl-9H-
carbazol-4-one เข้าจับในต าแหน่งที ่ใกล้เคียงกับยาควบคุมเช ิงบวก โดยที ่สารออกฤทธิ ์ 3 -
Methoxy-1 ,2 - dimethyl-9 H-carbazol-4 - one ม ี ค ่ า พ ล ั ง ง า น ก า ร ย ึ ด เ ก า ะ ก ั บ โ ป ร ตี น 
Cholinesterase ดีที่สุดหากเทียบกับสารออกฤทธิ์ทางชีวภาพในเขยตายทั้งหมด และดีกว่ายาควบคุม
เช ิงบวก 2 ชนิด ได ้แก่ Galantamine และ Rivastigmine แสดงให้เห ็นว ่า 3-Methoxy-1 ,2-
dimethyl-9H-carbazol-4-one สามารถเข้าจับกับโปรตีน Cholinesterase ได้ดีกว่ากว่ายาควบคุม
เชิงบวก 2 ชนิด 

      จากการศึกษาพบว่า Cholinesterase เป็นเป้าหมายการรักษาที่ส าคัญส าหรับโรคอัลไซ
เมอร์ เกี่ยวข้องการเสื่อมสภาพของเซลล์ประสาท โดย Cholinesterase สามารถสลาย Choline ซ่ึง
เป็นสารตั้งต้นที่ส าคัญส าหรับการสร้างสารสื่อประสาทในกระบวนการ cholinergic ในสมอง และการ
สูญเสียสารสื่อประสาทเป็นสาเหตุส าคัญท่ีท าให้สูญเสียการรับรู้ น าไปสู่การเป็นโรคอัลไซเมอร์ได้ 

4.4 การวิเคราะห์อันตรกิริยา 

      จากการทดลองการเข้าจับกันของโมเลกุลระหว่างสารออกฤทธิ์ทางชีวภาพต่อโปรตีน
เป้าหมายที่สัมพันธ์กับการเกิดโรคอัลไซเมอร์ เทียบกับยาควบคุมเชิงบวกที่ได้รับการขึ้นทะเบียนจาก 
FDA ในการรักษาโรคอัลไซเมอร์ ผลการทดลองแสดงให้เห็นว่าในเขยตายมีสารออกฤทธิ์ทางชีวภาพ
หลายชนิดที่มีค่าพลังงานการยึดเกาะดีกว่ายาควบคุมเชิงบวก แต่สารที่ให้พลังงานดีที่สุดในกลุ่มนี้ คือ 
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1-Methoxy-3-methyl-9H-carbazole แ ล ะ  3-Methoxy-1,2-dimethyl-9H-carbazol-4-one 
จากนั้นน าสาร 2 ชนิดนี้มาวิเคราะห์อันตรกิริยาผ่านโปรแกรม PLIP ผลการวิเคราะห์ ดังนี้ 
ตารางที่ 4.7 ผลการวิเคราะห์อันตกิริยา 

Target Ligand Interactions 

Acetylcholinesterase 

1-Methoxy-3-
methyl-9H-
carbazole 

Hydrogen bond: GLY-120 
Hydrophobic bond: ASP-74, TYR-337, TRP-86 
Pi-Stacking: TRP-86 

Donepezil 
Hydrogen bond: ASP-384 
Hydrophobic bond: VAL-330, ALA-397,  
VAL-480, VAL-429 

Galantamine 
Hydrogen bond: THR-238, ARG-247, ARG-296 
Hydrophobic bond: VAL-239, PRO-290 

Rivastigmine 
Hydrogen bond: ARG-296 
Hydrophobic bond: PRO-290, ARG-296,  
PHE-297, VAL-300, PRO-368, GLN-369 

Tacrine 
Hydrogen bond: ARG-525 
Hydrophobic bond: LYS-332, ASP-384,  
ARG-393, ALA-397 

Cholinesterase 

3-Methoxy-
1,2-dimethyl-
9H-carbazol-

4-one 

Hydrogen bond: HIS-438 
Hydrophobic bond: TRP-82, ALA-382,  
TYR-332, TRP-430,TYR-440 
Pi-Stacking: TRP-86 

Galantamine 
Hydrogen bond: GLU-197 
Hydrophobic bond: TRP-82 
Pi-Stacking: TRP-82 

Rivastigmine 

Hydrogen bond: GLY-116, GLY-117 
Hydrophobic bond: LEU-286, PHE-329,  
PHE-398 
Pi-Stacking: TRP-82, PHE-239 
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      4.4.1 การว ิ เ ค ราะห ์อ ั นตรก ิ ร ิ ย าของ  1 -Methoxy-3 -methyl-9H-carbazole  
เ ท ี ย บ ก ั บ ย า  Donepezil, Galantamine, Rivastigmine, แ ล ะ  tacrine ต ่ อ โ ป ร ตี น 
Acetylcholinesterase 

           จากการทดลองการเข้าจับกันของโมเลกุลระหว่าง 1-Methoxy-3-methyl-9H-
carbazole กับโปรตีน Acetylcholinesterase พบว่ามีค่าพลังงานการยึดเกาะดีกว่ายาควบคุมเชิง
บวกท่ีได้รับการขึ้นทะเบียนจาก FDA 4 ชนิด ได้แก่ Donepezil, Galantamine, Rivastigmine, และ 
Tacrine จึงน าสาร 1-Methoxy-3-methyl-9H-carbazole มาวิเคราะห์อันตรกิริยาเปรียบเทียบกับ
ยาทั้ง 4 ชนิด ดังภาพที่ 4.4 4.5 4.6 และ 4.7  

 

 

ภาพที่ 4.4 ก) โครงสร้างเชิงซ้อนระหว่างโมเลกุลสาร 1-Methoxy-3-methyl-9H-carbazole และยา 
Donepezil เกิดพันธะในการเข้าจับกับโปรตีน Acetylcholinesterase ข) การเกิดพันธะของโปรตีน 
Acetylcholinesterase (โครงสร้างสีฟ้า) กับ สาร 1-Methoxy-methyl-9H-carbazole (โครงสร้าง
ส้ม) พันธะไฮโดรเจน (เส้นทึบสีน ้าเงิน) แรงไฮโดรโฟบิก (เส้นประสีเทา) และการเรียงซ้อนพาย
(เส้นประสีเขียว)  ค) การเกิดพันธะของโปรตีน Acetylcholinesterase (โครงสร้างสีฟ้า) กับยา 
Donepezil (โครงสร้างส้ม) พันธะไฮโดรเจน (เส้นทึบสีน ้าเงิน) และแรงไฮโดรโฟบิก (เส้นประสีเทา)  

 

 

ก 

ข ค 

TYR-337 
TRP-86 

ASP-74 

GLY-120 
VAL-429 

VAL-330 

VAL-408 
ALA-397 

ASP-384 
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    จากภาพที่ 4.4 ก) เปรียบเทียบต าแหน่งการยึดเกาะของ 1-Methoxy-3-methyl-9H-
carbazole และยาDonepezil ต่อโปรตีน Acetylcholinesterase พบว่ามีบริเวณยึดเกาะแตกต่าง 
ภ า พ ที่ 4.4 ข )  พ บ ว ่ า ใ น ก า ร ย ึ ด เ ก า ะ ข อ ง  1-Methoxy-3-methyl-9H-carbazole ต่ อ 
Acetylcholinesterase เกิดพันธะไฮโดรเจน 1 ต าแหน่ง คือ GLY-120 เกิดแรงไฮโดรโฟบิก 3 

ต าแหน่ง คือ ASP-74 TYR-337 และ TRP-86 อีกทั้งเกิดการเรียงซ้อนพาย (π-Stacking) ที่ต าแหน่ง 
TRP-86 ส่วนภาพที่ 4.4 ค) เป็นการยึดเกาะของ Donepezil ต่อ Acetylcholinesterase เกิดพันธะ
ไฮโดรเจน 1 ต าแหน่ง คือ ASP-384 เกิดแรงไฮโดรโฟบิก 4 ต าแหน่ง คือ VAL-330 ALA-397  
VAL-480 และ VAL-429 สังเกตเห็นการยึดเกาะของ 1-Methoxy-3-methyl-9H-carbazole กับ 
Donepezil ม ีต  าแหน่งแตกต่างกัน ซ ึ ่งอาจพิจารณาได้ว ่าสามารถเข ้าย ับยั ้งการท างานของ 
Acetylcholinesterase แบบไม่แข่งขันกัน 

 

       
ภาพที่ 4.5 ก) โครงสร ้างเช ิงซ ้อนระหว ่างโมเลก ุลสาร 1-Methoxy-3-methyl-9H-

carbazole และยา Galantamine เกิดพันธะในการเข้าจับกับโปรตีน Acetylcholinesterase ข) 
การเกิดพันธะ ของโปรตีน Acetylcholinesterase (โครงสร้างสีฟ้า) กับ สาร 1-Methoxy-methyl-
9H-carbazole (โครงสร้างส้ม) พันธะไฮโดรเจน (เส้นทึบสีน ้าเงิน) แรงไฮโดรโฟบิก (เส้นประสีเทา)   
และการเรียงซ้อนพาย (เส้นประสีเขียว)  ค) การเกิดพันธะของโปรตีน Acetylcholinesterase 
(โครงสร้างสีฟ้า) กับยา Galantamine (โครงสร้างส้ม) พันธะไฮโดรเจน (เส้นทึบสีน ้าเงิน) และแรง
ไฮโดรโฟบิก (เส้นประสีเทา) 

ก 

ข ค GLY-120 

TYR-337 
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ASP-74 
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    จากภาพที่ 4.5 ก) เปรียบเทียบต าแหน่งการยึดเกาะของ 1-Methoxy-3-methyl-9H-
carbazole และยา Galantamine ต่อโปรตีน Acetylcholinesterase พบว่ามีบริเวณยึดเกาะแตกต่าง
ก ั น  ภาพที่  4.5 ข )  พบว ่ า ใ นก า ร ย ึ ด เ ก า ะ ข อ ง  1-Methoxy-3-methyl-9H-carbazole ต่ อ 
Acetylcholinesterase เกิดพันธะไฮโดรเจน 1 ต าแหน่ง คือ GLY-120 เกิดแรงไฮโดรโฟบิก 3 

ต าแหน่ง คือ ASP-74 TYR-337 และ TRP-86 อีกทั้งเกิดการเรียงซ้อนพาย (π-Stacking) ที่ต าแหน่ง 
TRP-86 และภาพที ่ 4.5 ค) เป็นการยึดเกาะของ Galantamine ต่อ Acetylcholinesterase เกิด
พันธะไฮโดรเจน 3 ต าแหน่ง คือ THR-238 ARG-247 และ ARG-296 เกิดแรงไฮโดรโฟบิก 2 ต าแหน่ง 
คือ VAL-239 และ PRO-290 สังเกตเห็นการยึดเกาะของ 1-Methoxy-3-methyl-9H-carbazole กับ 
Galantamine มีต าแหน่งแตกต่างกัน ซึ ่งอาจพิจารณาได้ว ่าสามารถเข้ายับยั ้งการท างานของ 
Acetylcholinesterase แบบไม่แข่งขันกัน 

 

         
 

ภาพที ่  4.6 ก) โครงสร ้างเช ิงซ ้อนระหว ่างโมเลก ุลสาร 1-Methoxy-3-methyl-9H-
carbazole และยา Rivastigmine เกิดพันธะในการเข้าจับกับโปรตีน Acetylcholinesterase ข) 
การเกิดพันธะ ของโปรตีน Acetylcholinesterase (โครงสร้างสีฟ้า) กับ สาร 1-Methoxy-methyl-
9H-carbazole (โครงสร้างส้ม) พันธะไฮโดรเจน (เส้นทึบสีน ้าเงิน) แรงไฮโดรโฟบิก (เส้นประสีเทา) 
และ การเรียงซ้อนพาย (เส้นประสีเขียว)  ค) การเกิดพันธะของโปรตีน Acetylcholinesterase 
(โครงสร ้างส ีฟ ้า)  กับยา Rivastigmine (โครงสร ้างส ้ม) พันธะไฮโดรเจน (เส ้นทึบส ีน  ้าเง ิน)  
และแรงไฮโดรโฟบิก (เส้นประสีเทา) 

ก 
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จากภาพที ่ 4.6 ก) เปรียบเทียบต าแหน่งการยึดเกาะของ 1-Methoxy-3-methyl-9H-
carbazole และยา Rivastigmine ต่อโปรตีน Acetylcholinesterase พบว่ามีบริเวณยึดเกาะแตกต่าง
ก ั น  ภาพท ี ่  4.6 ข )  พบว ่ า ใ นก า ร ย ึ ด เ ก า ะข อ ง  1-Methoxy-3-methyl-9H-carbazole ต่ อ 
Acetylcholinesterase เกิดพันธะไฮโดรเจน 1 ต าแหน่ง คือ GLY-120 เกิดแรงไฮโดรโฟบิก 3 

ต าแหน่ง คือ ASP-74 TYR-337 และ TRP-86 อีกทั้งเกิดการเรียงซ้อนพาย (π-Stacking) ที่ต าแหน่ง 
TRP-86 และภาพที ่ 4.6 ค) เป็นการยึดเกาะของ Rivastigmine ต่อ Acetylcholinesterase เกิด
พันธะไฮโดรเจน 1 ต าแหน่ง คือ ARG-296 เกิดแรงไฮโดรโฟบิก 6 ต าแหน่ง คือ PRO-290 ARG-296 
PHE-297 VAL-300 PRO-368 และ GLN-369 สังเกตเห็นการยึดเกาะของ 1-Methoxy-3-methyl-
9H-carbazole กับ Rivastigmine มีต าแหน่งแตกต่างกัน ซึ่งอาจพิจารณาได้ว่าสามารถเข้ายับยั้งการ
ท างานของ Acetylcholinesterase แบบไม่แข่งขันกัน 

 

    
ภาพที ่  4.7 ก) โครงสร ้างเช ิงซ ้อนระหว ่างโมเลก ุลสาร 1-Methoxy-3-methyl-9H-

carbazole และยา Tacrine เกิดพันธะในการเข้าจับกับโปรตีน Acetylcholinesterase ข) การเกิด
พันธะ ของโปรตีน Acetylcholinesterase (โครงสร้างสีฟ้า) กับ สาร 1-Methoxy-methyl-9H-
carbazole (โครงสร้างส้ม) พันธะไฮโดรเจน (เส้นทึบสีน ้าเงิน) แรงไฮโดรโฟบิก (เส้นประสีเทา) และ
การเรียงซ้อนพาย (เส้นประสีเขียว)  ค) การเกิดพันธะของโปรตีน Acetylcholinesterase(โครงสร้าง
สีฟ้า) กับยา Tacrine (โครงสร้างส้ม) พันธะไฮโดรเจน (เส้นทึบสีน ้าเงิน) และแรงไฮโดรโฟบิก 
(เส้นประสีเทา) 
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จากภาพที ่ 4.7 ก) เปรียบเทียบต าแหน่งการยึดเกาะของ 1-Methoxy-3-methyl-9H-
carbazole และยา Tacrine ต่อโปรตีน Acetylcholinesterase พบว่ามีบริเวณยึดเกาะแตกต่างกัน 
ภาพที่ 4.7 ข) พบว่าในการยึดเกาะของ 1-Methoxy-3-methyl-9H-carbazole ต่อ Tacrine เกิด
พันธะไฮโดรเจน 1 ต าแหน่ง คือ GLY-120 เกิดแรงไฮโดรโฟบิก 3 ต าแหน่ง คือ ASP-74 TYR-337 และ 

TRP-86 อีกท้ังเกิดการเรียงซ้อนพาย (π-Stacking) ที่ต าแหน่ง TRP-86 และภาพท่ี 4.7 ค) เป็นการยึด
เกาะของ Tacrine ต่อ Acetylcholinesterase เกิดพันธะไฮโดรเจน 1 ต าแหน่ง คือ ARG-525 เกิด
แรงไฮโดรโฟบิก 4 ต าแหน่ง คือ LYS-332 ASP-384 ARG-393 และ ALA-397 สังเกตเห็นการยึดเกาะ
ของ 1-Methoxy-3-methyl-9H-carbazole กับ Tacrine มีต าแหน่งแตกต่างกัน ซึ่งอาจพิจารณาได้
ว่าสามารถเข้ายับยั้งการท างานของ Acetylcholinesterase แบบไม่แข่งขันกัน 

      4.4.2 การวเิคราะหอ์นัตรกริยิาของ3-Methoxy-1,2-dimethyl-9H-carbazol-4- 
one เทยีบกบัยา Galantamine และ Rivastigmine ตอ่โปรตนี Cholinesterase 
      จากการทดลองการเข้าจับกันของโมเลกุลระหว่าง 3-Methoxy-1,2-dimethyl-
9H-carbazol-4-one กับโปรตีน Cholinesterase พบว่ามีค่าพลังงานการยึดเกาะดีกว่ายาควบคุม
เชิงบวกท่ีได้รับการขึ้นทะเบียนจาก FDA 2 ชนิด ได้แก่ Galantamine และ Rivastigmine จึงน าสาร 
3-Methoxy-1,2-dimethyl-9H-carbazol-4-one มาวิเคราะห์อันตรกิริยาเปรียบเทียบกับยาทั้ง 2 
ชนิด ดังภาพที่ 4.8 และ 4.9 

 

       
ภาพที ่ 4.8 ก) โครงสร้างเชิงซ้อนระหว่างโมเลกุลสาร 3-Methoxy-1,2-dimethyl-9H-

carbazol-4-one และยา Galantamine เก ิดพันธะในการเข ้าจ ับกับโปรต ีน  Cholinesterase  
ภาพท ี ่  4.8 ข )  กา ร เก ิ ดพ ั น ธะขอ ง โปรต ี น  Cholinesterase( โ ค ร งสร ้ า งส ี ฟ ้ า ) ก ั บ ส า ร 
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3-Methoxy-1,2-dimethyl-9H-carbazol-4-one (โครงสร้างส้ม) พันธะไฮโดรเจน (เส้นทึบสีน ้าเงิน) 
แรงไฮโดรโฟบิก (เส้นประสีเทา)และการเรียงซ้อนพาย(เส้นประสีเขียว) ภาพที่ 4.8 ค)การเกิดพันธะ
ของโปรตีน Cholinesteras (โครงสร้างสีฟ้า) กับยา Galantamine (โครงสร้างส้ม) พันธะไฮโดรเจน 
(เส้นทึบสีน ้าเงิน) แรงไฮโดรโฟบิก (เส้นประสีเทา) และการเรียงซ้อนพาย (เส้นประสีเขียว)   

จากภาพที่ 4.8 ก) เปรียบเทียบต าแหน่งการยึดเกาะของ 3-Methoxy-1,2-dimethyl-9H-
carbazol-4-oneและยา Galantamine ต่อโปรตีน Cholinesterase พบว่ามีบริเวณยึดเกาะต าแหน่ง
ใกล้เคียงกัน ภาพที่ 4.8 ข) พบว่าในการยึดเกาะของ 3-Methoxy-1,2-dimethyl-9H-carbazol-4-
one ต่อ Cholinesterase เกิดพันธะไฮโดรเจน 1 ต าแหน่ง คือ HIS-438 เกิดแรงไฮโดรโฟบิก 5 

ต าแหน่ง คือ TRP-82 ALA-382 TYR-332 TRP-430และ TYR-440 อีกทั้งเกิดการเรียงซ้อนพาย (π-
Stacking)  ท ี ่ต  าแหน ่ง TRP-82 และภาพท ี ่  4.8 ค) เป ็นการย ึดเกาะของ  Galantamine ต่อ 
Cholinesterase เกิดพันธะไฮโดรเจน 1 ต าแหน่ง คือ GLU-197 เกิดแรงไฮโดรโฟบิก 1 ต าแหน่ง คือ 
TRP-82 อีกท้ังเกิดการเรียงซ้อนพายที่ต าแหน่ง TRP-82 สังเกตเห็นการยึดเกาะของ 3-Methoxy-1,2-
dimethyl-9H-carbazol-4-one เกิดแรงไฮโดรโฟบิกต าแหน่งเดียวกับ Galantamine 1 ต าแหน่งคือ 
TRP-82 และมีการเรียงซ้อนพายที่ต าแหน่งเดียวกัน คือ TRP-82 ซึ่งอาจพิจารณาได้ว่าสามารถเข้า
ยับยั้งการท างานของ Cholinesterase แบบแข่งขันกัน 

 

                
ภาพที ่ 4.9 ก) โครงสร้างเชิงซ้อนระหว่างโมเลกุลสาร 3-Methoxy-1,2-dimethyl-9H-

carbazol-4-one และยา Rivastigmine เกิดพันธะในการเข้าจับกับโปรตีน Cholinesterase ข) การ
เกิดพันธะของโปรตีน Cholinesterase (โครงสร้างสีฟ้า) กับ สาร 3-Methoxy-1,2-dimethyl-9H-
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carbazol-4-one (โครงสร้างส้ม) พันธะไฮโดรเจน (เส้นทึบสีน ้าเงิน) แรงไฮโดรโฟบิก (เส้นประสีเทา) 
และการเรียงซ้อนพาย (เส้นประสีเขียว)  ค) การเกิดพันธะของโปรตีน Cholinesterase (โครงสรา้งสี
ฟ้า) กับยา Rivastigmine (โครงสร้างส้ม) พันธะไฮโดรเจน (เส้นทึบสีน ้าเงิน) และแรงไฮโดรโฟบิก 
(เส้นประสีเทา)  

จากภาพที่ 4.9 ก) เปรียบเทียบต าแหน่งการยึดเกาะของ 3-Methoxy-1,2-dimethyl-9H-
carbazol-4-oneและยา Rivastigmine ต่อโปรตีน Cholinesterase พบว่ามีบริเวณยึดเกาะต าแหน่ง
ใกล้เคียงกันภาพที่ 4.9 ข) พบว่าในการยึดเกาะของ 3-Methoxy-1,2-dimethyl-9H-carbazol-4-one 
ต่อ Cholinesterase เกิดพันธะไฮโดรเจน 1 ต าแหน่ง คือ HIS-438 เกิดแรงไฮโดรโฟบิก 5 ต าแหน่ง 

คือ TRP-82 ALA-382 TYR-332 TRP-430และ TYR-440 อีกทั้งเกิดการเรียงซ้อนพาย (π-Stacking) 
ที่ต าแหน่ง TRP-82 และภาพที่ 4.9 ค) เป็นการยึดเกาะของ Rivastigmine ต่อ Cholinesterase เกิด
พันธะไฮโดรเจน 2 ต าแหน่ง คือ GLY-116 และ GLY-117 เกิดแรงไฮโดรโฟบิก 3 ต าแหน่ง คือ LEU-

286 PHE-329 และ PHE-398 อีกทั้งเกิดการเรียงซ้อนพาย (π-Stacking) ที่ต าแหน่ง TRP-231 และ 
PHE-239 ส ั ง เ กต เห ็ นการย ึ ด เ กาะของ  3-Methoxy-1,2-dimethyl-9H-carbazol-4-one กั บ 
Rivastigmine มีต าแหน่งแตกต่างกัน ซึ ่งอาจพิจารณาได้ว ่าสามารถเข้ายับยั ้งการท างานของ 
Cholinesterase แบบไม่แข่งขันกัน 
 
4.5 การท านายคุณสมบัติทางเภสัชวิทยาของสารออกฤทธิ์ทางชีวภาพในเขยตายและยา  
 

      ท านายคุณสมบัติทางเภสัชวิทยาของสารออกฤทธิ์ทางชีวภาพทั้งหมดที่มีค่าพลังงานการ
ย ึ ด เ ก า ะ ดี ก ว ่ า ย า คว บค ุ ม เ ช ิ ง บ ว กแ ต ่ ล ะชน ิ ด ท ี ่ ไ ด ้ ร ั บ ก า ร ข ึ ้ น ท ะ เ บ ี ย น จ า ก  FDA  
ต ่ อ โ ป ร ต ี น  Acetylcholinesterase แ ล ะ โ ป ร ต ี น  Cholinesterase ด ้ ว ย  SwissADME 
(http://www.swissadme.ch/) ซึ ่งพิจารณาตามคุณสมบัต ิความเป็นยาตามกฎของลิป ินสกี้  
(Lipinski’ rule of five) คือน ้าหนักโมเลกุลน้อยกว่าหรือเท่ากับ 500, จ านวนการละลายในชั้นน ้า
และไขมัน Log Po/w (WLOGP) น้อยกว่าหรือเท่ากับ 4.15 จ านวนตัวรับพันธะไฮโดรเจนน้อยกว่าหรือ
เท่ากับ 5 และพันธะที่หมุนได้น้อยกว่าหรือเท่ากับ 10 ต่อมาพิจารณาคุณสมบัติเมแทบอลิซึม คือ การ
เป็นตัวยับยั้ง CYP2C19 (CYP2C19 inhibitor) ซึ่งมีบทบาทส าคัญต่อการเร่งการเผาผลาญของยา
หลายชนิด ส่งผลให้ยาไม่ตกค้างในร่างกายเป็นเวลานาน ลดความเป็นพิษของยาที่มีต่อร่างกาย 
จากนั้นท านายคุณสมบัติการเป็นพิษด้วย ProTox3 (https://tox.charite.de/protox3/) โดยการ
พิจารณาที่ Toxicity Class โดยระดับความเป็นพิษสูงสุดคือ Class 1 และความเป็นพิษน้อยสุดคือ 
Class 6 สุดท้ายพิจารณาค่า LD50 (50% lethal dose) หมายถึงระดับความเป็นพิษต่อร่างกายของ
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มนุษย์ โดยค านวณจากปริมาณสารที่ท าให้สัตว์ทดลองครึ่งหนึ่งตายจากการได้รับเพียงครั้งเดียว ผล
การท านายของสารออกฤทธิ์ทางชีวภาพในเขยตายดังตารางที่ 4.8 และผลการท านายของยาควบคุม 
เชิงบวก 4 ชนิดที่น ามาพิจารณา ดังตารางที่ 4.9  

ตารางที่ 4.8 แสดงค่าการตรวจสอบคุณสมบัติทางเภสัชวิทยาของสารออกฤทธิ์ทางชีวภาพในเขยตาย 

Compound name 
Drug likeness – 
Lipinski’ rule 

Pharmacokinetics -
CYP2C19 inhibitor 

Toxicity 
Class 

Predicted 
LD50 (mg/kg) 

Cytidine Yes; 0 violation No 4 826 

Hexadecanoic acid,  
methyl ester 

Yes; 1 violation: 
MLOGP>4.15 

No 5 5000 

n-Hexadecanoic acid 
Yes; 1 violation: 
MLOGP>4.15 

No 4 900 

1-Heptadecane 
Yes; 1 violation: 
MLOGP>4.15 

No 5 3000 

9,17-Octadecadienal 
Yes; 1 violation: 
MLOGP>4.15 

No 5 5000 

Octadecanoic acid 
Yes; 1 violation: 
MLOGP>4.15 

No 4 900 

1-Methoxy-3-methyl-
9H-carbazole 

Yes; 0 violation Yes 3 1200 

Vitamin e Yes; 0 violation No 5 5000 

Phytol 
Yes; 1 violation: 
MLOGP>4.15 

No 5 5000 

9,12,15-
Octadecatrien 

Yes; 1 violation: 
MLOGP>4.15 

No 6 11730 

Thioanthranilic acid Yes; 0 violation Yes 4 875 

3-Indazolone Yes; 0 violation No 4 1000 

Methyl palmitate 
Yes; 1 violation: 
MLOGP>4.15 

No 5 5000 
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Zingiberene 
Yes; 1 violation: 
MLOGP>4.15 

Yes 4 1680 

Gamma-Muurolene 
Yes; 1 violation: 
MLOGP>4.15 

Yes 4 1680 

Bicyclogermacrene 
Yes; 1 violation: 
MLOGP>4.15 

Yes 5 5300 

3-Methoxy-1,2-
dimethyl-9H-
carbazol-4-one 

Yes; 0 violation Yes 3 95 

Gamma-Pyronene Yes; 0 violation No 5 3450 

beta-
Sesquiphellandrene 

Yes; 1 violation: 
MLOGP>4.15 

Yes 5 5000 

Alpha-phenylindole Yes; 0 violation No 3 100 

Linoleic acid 
Yes; 1 violation: 
MLOGP>4.15 

No 6 10000 

2,3,6 -
Trimethylphenol 

Yes; 0 violation No 5 3200 

ตารางที่ 4.9 แสดงค่าการตรวจสอบคุณสมบัติทางเภสัชวิทยาของยาควบคุมเชิงบวก 

Drug name 
Drug likeness – 
Lipinski’ rule 

Pharmacokinetics -
CYP2C19 inhibitor 

Toxicity 
Class 

Predicted LD50 
(mg/kg) 

Donepezil Yes; 0 violation No 4 505 

Galantamine Yes; 0 violation No 3 85 

Rivastigmine Yes; 0 violation No 4 1000 
Tacrine Yes; 0 violation No 2 40 

  
    จากตารางที่ 4.8 พบว่าเมื่อพิจารณาตามกฎของลิปินสกี้ สารทั้งหมดที่น ามาทดสอบผ่าน

เกณฑ์การทดสอบ หากพิจารณาถึงการเป็นตัวยับยั้ง CYP2C19 มีสาร 7 ชนิด ที่มีผลการท านายว่า
เป็นตัวยั ้บยั ้ง CYP2C19  ได้แก่ 1-Methoxy-3-methyl-9H-carbazole, Thioanthranilic acid, 
Zingiberene, Gamma-Muurolene, Bicyclogermacrene, 3-Methoxy-1,2-dimethyl-9H-
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carbazol-4-one และ beta-Sesquiphellandrene ผลการท านายความเป็นพิษไม่มีสารชนิดไหนที่
มีความเป็นพิษรุนแรง 

    ผลการท านายทางเภสัชวิทยาของสารออกฤทธิ์ทางชีวภาพ 1-Methoxy-3-methyl-9H-
carbazole และ 3-Methoxy-1,2-dimethyl-9H-carbazol-4-one ผ่านเกณฑ์ตามคุณสมบัติความ
เป็นยาตามกฎของลิปินสกี้ แสดงถึงความสามารถในการดูดซึมและการกระจายตัวที่ดี เมื่อพิจารณาถึง
คุณสมบัติเมแทบอลิซึมและความเป็นพิษ สารทั้ง 2 เป็นตัวยับยั้ง CYP2C19 อาจส่งผลให้สารออก
ฤทธิ์ได้นาน และมีความเป็นพิษปานกลาง 
 
4.6 อภิปรายผลการทดลอง 
  
       จากการทดลองมีข้อบกพร่องบางประการเกี่ยวกับข้อมูลของโปรตีนเป้าหมาย และ
โปรแกรมที่ใช้ในการทดลอง ส่งผลให้อาจมีโปรตีนที่สัมพันธ์กับการเกิดโรคอัลไซเมอร์บางชนิด ไม่ถูก
น ามาวิเคราะห์ร่วมด้วย อย่างไรก็ตามจากข้อมูลโปรตีนเป้าหมายที่น ามาวิเคราะห์ในการทดลองนี้ 
สามารถบรรลุเป้าหมายตามวัตถุประสงค์ของงานวิจัย ได้แก่  เพื่อศึกษาการเข้าจับระดับโมเลกุลของ
สารออกฤทธิ์ทางชีวภาพในเขยตายกับโปรตีนเป้าหมายที่สัมพันธ์กับการเกิดโรคอัลไซเมอร์ และเพ่ือ
ประเมินศักยภาพของสารออกฤทธิ์ทางชีวภาพในเขยตายส าหรับการรักษาโรคอัลไซเมอร์ 
       งานวิจัยนี้ใช้ค่าพลังงานการยึดเกาะของยาควบคุมเชิงบวกที่องค์การอาหารและยาแห่ง
สหรัฐอเมริกาอนุมัต ิให้ใช ้ส าหรับการรักษาโรคอัลไซเมอร์ที ่ม ีค ่าพลังงานแย่ที ่ส ุดต่อโปรตีน 
Acetylcholinesterase และ Cholinesterase มาใช้เป็นเกณฑ์การคัดเลือกสารออกฤทธิ์ทางชีวภาพ 
เนื่องจากต้องการค้นหาสารในเขยตายที่อาจมีศักยภาพเทียบเท่าหรือมากกว่ายาที่มีอยู่ในปัจจุบันให้ได้
จ านวนมากที่สุด เพื่อเป็นทางเลือกส าหรับการน าไปทดลองหรือประยุกต์ใช้ในด้านต่าง ๆ ตาม
วัตถปุระสงค์ รวมทั้งสารบางชนิดอาจมีข้อจ ากัดแตกต่างกัน และเนื่องจากผลการท านายความเป็นพิษ
ของสารในเขยตายที่ผ่านเกณฑ์การคัดเลือก 22 ชนิด อยู่ในเกณฑ์ความเป็นพิษปานกลาง (Toxicity 
call 3 และ 4) การประยุกต์ใช้ในรูปแบบการสกัดแยกเฉพาะสารที่มีประสิทธิภาพเหมาะสมส าหรับ
การรักษาโรคอัลไซเมอร์อาจส่งผลดีมากกว่าการประยุกต์ใช้ในรูปแบบสารสกัดหยาบในระยะยาว 
       งานวิจัยนี้ใช้วิธีทางชีวสารสนเทศในการท านายผลการทดลองทั้งหมด เพราะฉะนั้นจึงมี
ความน่าเชื่อถือในระดับหนึ่งเท่านั้น ผลจากงานวิจัยนี้สามารถเป็นแนวทางต่อยอดองค์ความรู้เพ่ือ
ศึกษาทดลองในห้องปฏิบัติการ สัตว์ทดลอง และการวิจัยในคน  
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      การศึกษานี้ได้เพิ่มความรู้ความเข้าใจเกี่ยวกับการยึดเกาะระดับโมเลกุลและอันตรกิรยิา
ของโครงสร้างสารออกฤทธิ์ทางชีวภาพในเขยตายกับโครงสร้างโปรตีนเป้าหมายที่สัมพันธ์กับการเกิด
โรคอัลไซเมอร์ เท่าที่ค้นคว้ามาพบว่างานวิจัยชิ้นนี้เป็นการศึกษาการยึดเกาะระดับโมเลกุลของสาร
ออกฤทธิ ์ทางชีวภาพในเขยตายต่อโปรตีนที ่ส ัมพันธ์กับการเกิดโรคอัลไซเมอร์ด้วยเทคนิคทาง  
ชีวสารสนเทศเป็นครั้งแรก นอกจากนี้ยังเป็นการพัฒนาพืชสมุนไพรหรือสารออกฤทธิ์ทางชีวภาพให้
เป็นที่น่าสนใจ น่าเชื่อถือ และเพื่อเป็นข้อมูลให้มีการน าสมุนไพรมาใช้ประโยชน์อย่างมีประสิทธิภาพ 
เสริมสร้างคุณภาพชีวิต และเศรษฐกิจต่อไป 
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บทที ่5  
สรปุผลการวจิัย 

 
5.1 สรุปผลการทดลอง 

      จากการทดลองในส่วนการคัดเลือกโครงสร้างสามมิติ ได้โครงสร้างในรูปแบบไฟล์
นามสกุล *.pdb ของสารออกฤทธ์ทางชีวภาพในเขยตาย จากฐานข้อมูล PubChem จ านวน 40 ชนิด 
โครงสร้างของโปรตีนเป้าหมายที่สัมพันธ์กับการเกิดโรคอัลไซเมอร์ จากฐานข้อมูล RCSB PDB จ านวน 
46 ชนิด และโครงสร้างของยาควบคุมเชิงบวกที่เกี่ยวข้องกับการรักษาโรคอัลไซเมอร์ จาก DrugBank 
จ านวน 23 ชนิด  

      จากผลการทดลองส่วนของการท านายบริเวณเข้าจับผ่าน PrankWeb พบว่าโปรตีน 
Acetylcholinesterase และ Cholinesterase บริเวณเข้าจับที่มีความน่าจะเป็นสูงที่สุดมีค่าเท่ากับ 
83.7 % และ 92.4 % ตามล าดับ ซึ่งเป็นบริเวณท่ีสารตั้งต้นสามารถเข้าจับได้ดีที่สุด โดยคาดคะเนจาก
บริเวณท่ีมีการเข้าจับบ่อยครั้ง  

      จากการทดสอบการเข้าจับกันระหว่างโมเลกุลด้วยโปรแกรม Autodock Vina โดยลิ
แกนด์ คือ สารออกฤทธิ์ทางชีวภาพในเขยตาย 40 ชนิด และยาควบคุมเชิงบวกที่เกี่ยวข้องกับการ
รักษาโรคอัลไซเมอร์ 23 ชนิด ต่อโปรตีนเป้าหมายที่เกี่ยวข้องกับการเกิดโรคอัลไซเมอร์ 46 ชนิด โดย
พิจารณาน าผลการทดลองของยาควบคุมเชิงบวก 4 ชนิดที่ได้รับการอนุมัติจาก FDA ให้ใช้รักษา
โรคอัลไซเมอร์ในปัจจุบันมาเปรียบเทียบกับผลการทดลองของสารออกฤทธิ์ทางชีวภาพในเขยตาย 
พบว่าเมื่อเข้าจับกับโปรตีน Acetylcholinesterase มีสารออกฤทธิ์ทางชีวภาพในเขยตาย 22 ชนิด ที่
มีค่าพลังงานการยึดเกาะดีกว่ายาควบคุมเชิงบวกอย่าง Rivastigmine และเมื่อเข้าจับกับโปรตีน 
Cholinesterase มีสารออกฤทธิ์ทางชีวภาพในเขยตาย 4 ชนิด ที่มีค่าพลังงานการยึดเกาะดีกว่ายา
ค ว บ ค ุ ม เ ช ิ ง บ ว ก อย ่ า ง  Rivastigmine ส า ร ท ี ่ ม ี ค ่ า พ ล ั ง ง า น ก า ร ย ึ ด เ ก า ะต ่ อ โ ป ร ตี น 
Acetylcholinesterase ที่ดีที่สุดคือ 1-Methoxy-3-methyl-9H-carbazole มีค่าเท่ากับ -8.5 กิโล
แคลอรี ่ต่อโมล และสารที ่มีค่าพลังงานการยึดเกาะต่อโปรตีน  Cholinesterase ที ่ดีที ่สุดคือ 3-
Methoxy-1,2-dimethyl-9H-carbazol-4-one มีค่าเท่ากับ -9.2 กิโลแคลอรี่ต่อโมล ในขณะที่ค่า
พล ังงานการย ึดเกาะของ  Donepezil Galantamine Rivastigmine และ Tacrine ต ่อโปรตีน 
Acetylcholinesterase มีค่าเท่ากับ -7.8 -7.0 -6.2 และ -7.6 กิโลแคลอรี่ต่อโมล  ต า ม ล  า ดั บ 
และต่อโปรตีน Cholinesterase มีค่าเท่ากับ -9.6 -8.7 -7.7 และ -10.5 กิโลแคลอรี่ต่อโมล แสดงให้
เห็นว่าสารออกฤทธิ์ทางชีวภาพในเขยตาย 2 ชนิด ได้แก่ 1-Methoxy-3-methyl-9H-carbazole มี
ศักยภาพในการเข้าจับกับโปรตีน Acetylcholinesterase ได้ดีกว่ายาควบคุมเชิงบวกทั้ง 4 ชนิด 
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ได้แก่ Donepezil Galantamine Rivastigmine และ Tacrine และ 3-Methoxy-1,2-dimethyl-
9H-carbazol-4-one มีศักยภาพในการเข้าจับกับโปรตีน Cholinesterase ได้ดีกว่ายาควบคุมเชิง
บวก 2 ชนิด ได้แก่ Galantamine Rivastigmine 

      ต่อมาเป็นการวิเคราะห์อันตรกิริยาผ่านโปรแกรม PLIP พบว่าการยึดเกาะของสาร 1-
Methoxy-3-methyl-9H-carbazole ต่อโปรตีน Acetylcholinesterase เกิดพันธะไฮโดรเจน 1 
ต าแหน่ง คือ GLY-120 เกิดแรงไฮโดรโฟบิก 3 ต าแหน่ง คือ ASP-74 TYR-337 และ TRP-86 อีกทั้ง

เกิดการเรียงซ้อนพาย (π-Stacking) ที่ต าแหน่ง TRP-86 โดยการยึดเกาะของสาร 1-Methoxy-3-
methyl-9H-carbazole กับยา Donepezil Galantamine Rivastigmine และ Tacrine ต่อโปรตีน 
Acetylcholinesterase ม ี ต  า แ ห น ่ ง แ ต ก ต ่ า ง ก ั น  ส า ม า ร ถ เ ข ้ า ย ั บ ย ั ้ ง ก า ร ท  า ง า น ข อ ง 
Acetylcholinesterase แบบไม่แข่งขันกัน อาจพิจารณาใช้เป็นตัวยับยั ้ง Acetylcholinesterase 
เ ส ร ิ ม ก ั น ไ ด ้  ส ่ ว น ก า ร ย ึ ด เ ก า ะ ข อ ง  3-Methoxy-1,2-dimethyl-9H-carbazol-4-one ต่ อ 
Cholinesterase เกิดพันธะไฮโดรเจน 1 ต าแหน่ง คือ HIS-438 เกิดแรงไฮโดรโฟบิก 5 ต าแหน่ง คือ 

TRP-82 ALA-382 TYR-332 TRP-430และ TYR-440 อีกทั้งเกิดการเรียงซ้อนพาย (π-Stacking) ที่
ต าแหน่ง TRP-82 มีการเกิดแรงไฮโดรโฟบิกต าแหน่งเดียวกับ Galantamine 1 ต าแหน่งคือ TRP-82 
และมีการเรียงซ้อนพายที่ต าแหน่งเดียวกัน คือ TRP-82 ซึ่งอาจพิจารณาได้ว่าสามารถเข้ายับยั้งการ
ท างานของ Cholinesterase แบบแข่งขันกัน อาจไม่สามารถใช้ร่วมกันได้ แต่มีต าแหน่งแตกต่างกันกับ 
Rivastigmine สามารถเข้ายับยั้งการท างานของ Cholinesterase แบบไม่แข่งขันกัน อาจพิจารณาใช้
เป็นตัวยับยั้ง Acetylcholinesterase เสริมกันได ้

      สุดท้ายผลการท านายคุณสมบัติทางเภสัชวิทยาของสารออกฤทธิ์ทางชีวภาพทั้งหมดที่มี
ค่าพลังงานการยึดเกาะดีกว่ายาควบคุมเชิงบวกแต่ละชนิดต่อโปรตีน Acetylcholinesterase และ
โปรตีน Cholinesterase โดยพิจารณาตามคุณสมบัติความเป็นยาตามกฎของลิปินสกี้ เมแทบอลิซึม 
และคุณสมบัติการเป็นพิษ พบว่าสารออกฤทธิ์ทางชีวภาพ 1-Methoxy-3-methyl-9H-carbazole 
และ 3-Methoxy-1,2-dimethyl-9H-carbazol-4-one ผ่านเกณฑ์ตามคุณสมบัติความเป็นยาตามกฎ
ของลิปินสกี้ แสดงถึงความสามารถในการดูดซึมและการกระจายตัวที่ดี เมื่อพิจารณาถึงคุณสมบัติเม
แทบอลิซึมและความเป็นพิษ สารทั้ง 2 ชนิดเป็นตัวยับยั้ง CYP2C19 อาจส่งผลให้สารออกฤทธิ์ได้นาน 
และมีความเป็นพิษปานกลาง
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